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Conventions used in this guide

TIP: Tips provide helpful hints or shortcuts.

NOTE: Notes provide important information to explain a concept or to complete a task.

CAUTION: Cautions indicate procedures that you should follow to avoid losing data or damaging
the product.

WARNING! Warnings alert you to specific procedures that you should follow to avoid personal
injury, catastrophic loss of data, or extensive damage to the product.
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1 Product basics

● Product comparison

● Environmental features

● Accessibility features

● Product views
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Product comparison

HP LaserJet Pro CP1025

CE913A

HP LaserJet Pro CP1025nw

CE914A

● Speed: Prints up to 16 A4-size pages per minute (ppm) or 17
letter-size ppm monochrome and 4 ppm color

● Tray: 150 sheets of 75 g/m2 (20 lb)

● Output bin: 50 sheets of 75 g/m2 (20 lb)

● Connectivity: Hi-Speed USB 2.0 port

● Two-sided printing (duplexing): Manual duplexing (using
the printer driver)

● Introductory print cartridge: Supplied with product

HP LaserJet Pro CP1025 plus:

● Connectivity: 802.11b/g/n wireless networking, built-in
networking to connect to 10Base-T/100Base-TX networks

● Internal networking: HP internal networking port

Environmental features

Recycling Reduce waste by using recycled paper.

Recycle print cartridges by using the HP return process.

Energy savings Save energy with HP Auto-On/Auto-Off Technology.

Manual duplex printing Save paper by using the manual duplex printing setting.

Print multiple pages per
sheet

Save paper by printing two or more pages of a document side-by-side on one sheet of paper.
Access this feature through the printer driver.
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Accessibility features
The product includes several features that aid users with accessibility issues.

● Online user guide that is compatible with text screen-readers.

● Print cartridges and the imaging drum can be installed and removed by using one hand.

● All doors and covers can be opened by using one hand.
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Product views

Product front view

1

3

4

6

5

2

1 Output bin

2 Control panel

3 Power button

4 Main-input tray

5 Front cover (provides access to the imaging drum)

6 Print cartridge door (provides access to the cyan, magenta, yellow, and black print cartridges)
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Product back view

1

3

4

5

2

1 Kensington lock

2 Rear jam-access door

3 HP internal network port (network models only)

4 USB port

5 Power receptacle

Serial number and model number location

The label that contains the product and serial numbers is on the inside of the front cover.
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Control panel layout

1

89

2

3

4

5

6

7

1
 Wireless button and light

Press and hold the button to enable Wi-Fi Protected
Setup (WPS) (network models only). The light
indicates the state of the wireless connection.

2-5
 Cartridge buttons and lights

When the print cartridge door is closed, press the
button to access the print cartridge of the
corresponding color. The light indicates the state of
the print cartridge.

6
 Attention light

Indicates that the print-cartridge door is open or
other errors exist.

7
 Ready light

When the light is on, the product is ready to print,
When the light is blinking, the product is processing
data.

8
 Resume button

Press to resume a print job.

9
 Cancel button

Press to cancel a print job.
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2 Software for Windows

● Supported operating systems for Windows

● Supported printer drivers for Windows

● Change print job settings for Windows

● Change printer-driver settings for Windows

● Remove software for Windows

● Supported utilities for Windows (network models only)
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Supported operating systems for Windows
The product comes with software for the following Windows® operating systems:

● Windows 7 (32-bit and 64-bit)

● Windows Vista (32-bit and 64-bit)

● Windows XP (32-bit, Service Pack 2)

● Windows Server 2003 (32-bit, Service Pack 3)

● Windows Server 2008 (32-bit and 64-bit)

Supported printer drivers for Windows
The product comes with software for Windows that allows the computer to communicate with the
product. This software is called a printer driver. Printer drivers provide access to product features,
such as printing on custom-sized paper, resizing documents, and inserting watermarks.

NOTE: The most recent drivers are available at www.hp.com/support/ljcp1020series.
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Change print job settings for Windows

Tool for changing the settings Method for changing the
settings

Duration of changes Hierarchy of changes

Software program settings On the File menu in the software
program, click Page Setup or a
similar command.

These settings are in effect for
the current print job only.

Settings changed here override
settings changed anywhere
else.

Printer Properties in the
software program

The steps vary for each
software program. This
procedure is most common.

1. On the File menu in the
software program, click
Print.

2. Select the product, and
then click Properties or
Preferences.

3. Change the settings on any
of the tabs.

These settings are in effect for
the current session of the
software program.

Settings changed here override
default printer driver settings
and default product settings.

Default printer driver settings 1. Open the list of printers on
your computer, and select
this product.

NOTE: This step varies
for each operating system.

2. Click Printer, and then
click Printing
Preferences.

3. Change the settings on any
of the tabs.

These settings remain in effect
until you change them again.

NOTE: This method changes
the default settings for the
printer driver for all software
programs.

You can override these settings
by changing settings in the
software program.
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Change printer-driver settings for Windows

Change the settings for all print jobs until the software program is closed

1. On the File menu in the software program, click Print.

2. Select the driver, and then click Properties or Preferences.

The steps can vary; this procedure is most common.

Change the default settings for all print jobs

1. Windows XP, Windows Server 2003, and Windows Server 2008 (using the default Start
menu view): Click Start, and then click Printers and Faxes.

Windows XP, Windows Server 2003, and Windows Server 2008 (using the Classic Start
menu view): Click Start, click Settings, and then click Printers.

Windows Vista: Click Start, click Control Panel, and then in the category for Hardware and
Sound click Printer.

Windows 7: Click Start, and then click Devices and Printers.

2. Right-click the driver icon, and then select Printing Preferences.

Change the product configuration settings

1. Windows XP, Windows Server 2003, and Windows Server 2008 (using the default Start
menu view): Click Start, and then click Printers and Faxes.

Windows XP, Windows Server 2003, and Windows Server 2008 (using the Classic Start
menu view): Click Start, click Settings, and then click Printers.

Windows Vista: Click Start, click Control Panel, and then in the category for Hardware and
Sound click Printer.

Windows 7: Click Start, and then click Devices and Printers.

2. Right-click the driver icon, and then select Properties or Printer properties.

3. Click the Configure tab.
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Remove software for Windows

Windows XP

1. Click Start, and then click Programs.

2. Click HP, and then click the product name.

3. Click Uninstall, and then follow the onscreen instructions to remove the software.

Windows Vista and Windows 7

1. Click Start, and then click All Programs.

2. Click HP, and then click the product name.

3. Click Uninstall, and then follow the onscreen instructions to remove the software.
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Supported utilities for Windows (network models only)
● HP Embedded Web Server (The HP EWS is only accessible when the product is network

connected, not when the product is connected via USB.)
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3 Use the product with Mac

● Software for Mac

● Print with Mac
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Software for Mac

Supported operating systems for Mac

The product supports the following Mac operating systems:

● Mac OS X 10.5, 10.6, and later

NOTE: For Mac OS X 10.5 and later, PPC and Intel® Core™ Processor Macs are supported. For
Mac OS X 10.6, Intel Core Processor Macs are supported.

Supported printer drivers for Mac

The HP LaserJet software installer provides PostScript® Printer Description (PPD) files, and Printer
Dialog Extensions (PDEs) for use with Mac OS X computers. The HP printer PPD and PDE files, in
combination with the product printer driver, provide full printing functionality and access to specific
HP printer features.

Install software for Mac operating systems

Install software for Mac computers connected directly to the product

This product supports a USB 2.0 connection. Use an A-to-B type USB cable. HP recommends using
a cable that is no longer than 2 m (6.5 ft).

1. Connect the USB cable to the product and the computer.

2. Install the software from the CD.

3. Click HP Installer icon, and follow the onscreen instructions.

4. On the Congratulations screen, click the OK button.

5. Print a page from any program to make sure that the printing software is correctly installed.
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Install software for Mac computers on a wired network

Configure the IP address

1. Connect the network cable to the product and to the network.

2. Wait for 60 seconds before continuing. During this time, the network recognizes the product and
assigns an IP address or host name for the product.

3. Press and hold the Resume  button for two to three seconds to print a configuration page and
a supplies status page.

4. Find the IP address on the configuration report.

LASERJET PROFESSIONAL 

Install the software

1. Quit all programs on the computer.

2. Install the software from the CD.

3. Click the HP Installer icon, and follow the onscreen instructions.

4. On the Congratulations screen, click the OK button.

5. Print a page from any program to make sure that the printing software is correctly installed.
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Install software for Mac computers on a wireless network

Before installing the product software, make sure the product is not connected to the network using a
network cable.

If your wireless router does not support Wi-Fi Protected Setup (WPS), obtain the wireless router
network settings from your system administrator, or complete the following tasks:

● Obtain the wireless network name or service set identifier (SSID).

● Determine the security password or encryption key for the wireless network.

Connect the product to a wireless network using WPS

If your wireless router supports Wi-Fi Protected Setup (WPS), this is the simplest way to set up the
product on a wireless network.

1. Press the WPS button on your wireless router.

2. Press and hold the Wireless  button on the product control panel for two seconds. Release the
button when the wireless light starts blinking.

3. Wait up to two minutes while the product establishes a network connection with the wireless
router.

NOTE: If this method is not successful, try using the wireless network using USB cable method.

Connect the product to a wireless network using a USB cable

If your wireless router does not support WiFi-Protected Setup (WPS), use this method to set up the
product on a wireless network. Using a USB cable to transfer settings makes setting up a wireless
connection easier. After the setup is complete, you can disconnect the USB cable and use the
wireless connection.

1. Insert the software CD into the computer CD tray.

2. Follow the on-screen instructions. When prompted, select the Connect through a wireless
network option. Connect the USB cable to the product when prompted.

CAUTION: Do not connect the USB cable until the installation program prompts you.

3. When the installation is complete, print a configuration page to make sure that the product has a
SSID name.

4. When installation is complete, disconnect the USB cable.

Remove software from Mac operating systems

You must have administrator rights to remove the software.

1. Disconnect the product from the computer.

2. Open Applications.

3. Select Hewlett Packard.

4. Select HP Uninstaller.
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5. Select the product from the list of devices, and then click the Uninstall button.

6. After the software is uninstalled, restart the computer and empty the Trash.

Change printer-driver settings for Mac

Change the settings for all print jobs
until the software program is closed

Change the default settings for all
print jobs

Change the product configuration
settings

1. On the File menu, click the Print
button.

2. Change the settings that you want
on the various menus.

1. On the File menu, click the Print
button.

2. Change the settings that you want
on the various menus.

3. On the Presets menu, click the
Save As... option and type a name
for the preset.

These settings are saved in the
Presets menu. To use the new
settings, you must select the saved
preset option every time you open a
program and print.

Mac OS X 10.5 and 10.6

1. From the Apple menu , click the

System Preferences menu and
then click the Print & Fax icon.

2. Select the product in the left side
of the window.

3. Click the Options & Supplies
button.

4. Click the Driver tab.

5. Configure the installed options.
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Software for Mac computers

Supported utilities for Mac (network models only)

HP Utility for Mac

Use the HP Utility to set up product features that are not available in the printer driver.

You can use the HP Utility when the product uses a universal serial bus (USB) cable or is connected
to a TCP/IP-based network.

Open the HP Utility

▲ From the dock, click HP Utility.

-or-

From Applications, click Hewlett Packard, and then click HP Utility.

HP Utility features

Use the HP Utility software to perform the following tasks:

● Obtain information about supplies status.

● Obtain information about the product, such as the firmware version and the serial number.

● Print a configuration page.

● For products connected to an IP-based network, obtain network information and open the
HP Embedded Web Server.

● Configure the paper type and size for the tray.

● Transfer files and fonts from the computer to the product.

● Update the product firmware.

● Display the color usage page.

Supported utilities for Mac

HP Embedded Web Server

The product is equipped with an embedded Web server, which provides access to information about
product and network activities.
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Print with Mac

Cancel a print job with Mac

1. If the print job is currently printing, cancel it by pressing the Cancel  button on the product
control panel.

NOTE: Pressing the Cancel  button clears the job that the product is currently processing. If
more than one process is running, pressing the Cancel  button clears the process that
currently appears on the product control panel.

2. You can also cancel a print job from a software program or a print queue.

● Software program: Typically, a dialog box appears briefly on the computer screen,
allowing you to cancel the print job.

● Mac print queue: Open the print queue by double-clicking the product icon in the dock.
Highlight the print job, and then click Delete.

Change the paper size and type with Mac

1. On the File menu in the software program, click the Print option.

2. In the Copies & Pages menu, click the Page Setup button.

3. Select a size from the Paper Size drop-down list, and then click the OK button.

4. Open the Finishing menu.

5. Select a type from the Media-type drop-down list.

6. Click the Print button.

Resize documents or print on a custom paper size with Mac

Mac OS X 10.5 and 10.6

Use one of these methods.

1. On the File menu, click the Print option.

2. Click the Page Setup button.

3. Select the product, and then select the correct settings for the Paper Size
and Orientation options.

1. On the File menu, click the Print option.

2. Open the Paper Handling menu.

3. In the Destination Paper Size area, click the Scale to fit paper size box,
and then select the size from the drop-down list.

Create and use printing presets with Mac

Use printing presets to save the current printer driver settings for reuse.
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Create a printing preset

1. On the File menu, click the Print option.

2. Select the driver.

3. Select the print settings that you want to save for reuse.

4. In the Presets menu, click the Save As... option, and type a name for the preset.

5. Click the OK button.

Use printing presets

1. On the File menu, click the Print option.

2. Select the driver.

3. In the Presets menu, select the printing preset.

NOTE: To use printer-driver default settings, select the standard option.

Print a cover page with Mac

1. On the File menu, click the Print option.

2. Select the driver.

3. Open the Cover Page menu, and then select where to print the cover page. Click either the
Before Document button or the After Document button.

4. In the Cover Page Type menu, select the message that you want to print on the cover page.

NOTE: To print a blank cover page, select the standard option from the Cover Page Type
menu.

Print multiple pages on one sheet of paper with Mac

1. On the File menu, click the Print option.

2. Select the driver.

3. Open the Layout menu.
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4. From the Pages per Sheet menu, select the number of pages that you want to print on each
sheet (1, 2, 4, 6, 9, or 16).

5. In the Layout Direction area, select the order and placement of the pages on the sheet.

6. From the Borders menu, select the type of border to print around each page on the sheet.

Print on both sides of the page (duplex) with Mac

1. Insert enough paper into one of the trays to accommodate the print job.

2. On the File menu, click the Print option.

3. Open the Layout menu, and click the Manual Duplex tab or open the Manual Duplex menu.

4. Click the Manual Duplex box, and select a binding option.

5. Click the Print button. Follow the instructions in the pop-up window that appears on the
computer screen before replacing the output stack in Tray 1 for printing the second half.

6. Go to the product, and remove any blank paper that is in Tray 1.

7. Retrieve the printed stack from the output bin, and, maintaining the paper orientation, place it
with the printed-side facing down in the input tray.

8. At the computer, click the Continue button to print the second side of the job. If at the product,
press the Resume  button.

Set the color options with Mac

Use the Color Options menu or the Color/Quality Options menu to control how colors are
interpreted and printed from software programs.

1. On the File menu, click the Print option.

2. Select the driver.

3. Open the Color Options menu or the Color/Quality Options menu.

4. Open the Advanced menu, or select the appropriate tab.

5. Adjust the individual settings for text, graphics, and photographs.
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4 Connect the product

● Supported network operating systems (network models only)

● Connect with USB

● Connect to a network (network models only)
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Supported network operating systems (network models
only) 

The product supports the following operating systems for wireless printing:

● Windows 7 (32-bit and 64-bit)

● Windows Vista (32-bit and 64-bit)

● Windows XP (32-bit, Service Pack 2)

● Windows Server 2003 (32-bit, Service Pack 3)

● Windows Server 2008 (32-bit and 64-bit)

● Mac OS X v10.5 and v10.6

Printer sharing disclaimer

HP does not support peer-to-peer networking, as the feature is a function of Microsoft operating
systems and not of the HP printer drivers. Go to Microsoft at www.microsoft.com.
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Connect with USB
This product supports a USB 2.0 connection. Use an A-to-B type USB cable. HP recommends using
a cable that is no longer than 2 m (6.5 ft).

CAUTION: Do not connect the USB cable until the installation software prompts you to connect it.

CD installation

1. Quit all open programs on the computer.

2. Install the software from the CD, and follow the onscreen instructions.

3. When prompted, select the Directly connect to this computer using a USB cable option, and
then click the Next button.

4. When the software prompts you, connect the USB cable to the product and the computer.

5. At the end of the installation, click the Finish button.

6. On the More Options screen, you can install more software, or click the Finish button.

7. Print a page from any program to make sure that the printing software is correctly installed.
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Connect to a network (network models only)
The product can connect to wired or wireless networks.

NOTE: You cannot connect to a wired and wireless network simultaneously. Wired connections
take precedence.

Supported network protocols

To connect a networking-equipped product to a network, you need a network that uses one of the
following protocols.

● TCP/IP (IPv4 or IPv6)

● Port 9100

● LPR

● DHCP

● AutoIP

● SNMP

● Bonjour

● SLP

● WSD

● NBNS

Install the product on a wired network

Configure the IP address

1. Connect the network cable to the product and to the network.

2. Wait for 60 seconds before continuing. During this time, the network recognizes the product and
assigns an IP address or host name for the product.
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3. Press and hold the Resume  button for two to three seconds to print a configuration page and
a supplies status page.

4. Find the IP address on the configuration report.

LASERJET PROFESSIONAL 

Install the software

1. Quit all programs on the computer.

2. Install the software from the CD.

3. Follow the onscreen instructions.

4. When prompted, select the Connect through a wired network option, and then click the Next
button.

5. From the list of available printers, select the printer that has the correct IP address.

6. Click the Finish button.

7. On the More Options screen, you can install more software, or click the Finish button.

8. Print a page from any program to make sure that the printing software is correctly installed.

Install the product on a wireless network 

Before installing the product software, make sure the product is not connected to the network using a
network cable.

If your wireless router does not support Wi-Fi Protected Setup (WPS), obtain the wireless router
network settings from your system administrator, or complete the following tasks:

● Obtain the wireless network name or service set identifier (SSID).

● Determine the security password or encryption key for the wireless network.

Connect the product to a wireless network using WPS

If your wireless router supports Wi-Fi Protected Setup (WPS), this is the simplest way to set up the
product on a wireless network.

1. Press the WPS button on your wireless router.

2. Press and hold the Wireless  button on the product control panel for two seconds. Release the
button when the wireless light starts blinking.

3. Wait up to two minutes while the product establishes a network connection with the wireless
router.
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NOTE: If this method is not successful, try using the wireless network setup using the USB cable
method.

Connect the product to a wireless network using a USB cable

If your wireless router does not support WiFi-Protected Setup (WPS), use this method to set up the
product on a wireless network. Using a USB cable to transfer settings makes setting up a wireless
connection easier. After the setup is complete, you can disconnect the USB cable and use the
wireless connection.

1. Insert the software CD into the computer CD tray.

2. Follow the on-screen instructions. When prompted, select the Connect through a wireless
network option. Connect the USB cable to the product when prompted.

CAUTION: Do not connect the USB cable until the installation program prompts you.

3. When the installation is complete, print a configuration page to make sure that the product has a
SSID name.

4. When installation is complete, disconnect the USB cable.

Install the software for a wireless product currently on the network

If the product already has an IP address on a wireless network and you want to install product
software on a computer, complete the following steps.

1. From the product control panel, print a configuration page to obtain the product IP address.

2. Install the software from the CD.

3. Follow the on-screen instructions.

4. When prompted, select the Connect through a wireless network option, and then click the
Next button.

5. From the list of available printers, select the printer that has the correct IP address.

Disconnect from the wireless network

If you want to disconnect the product from a wireless network, you can turn off the wireless unit in the
product.

1. At the product control panel, press and release the Wireless  button.

2. To confirm that the wireless unit is turned off, print a configuration page and then verify that the
status is specified as disabled on the configuration page.
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Reduce interference on a wireless network

The following tips can reduce interference in a wireless network:

● Keep the wireless devices away from large metal objects, such as filing cabinets, and other
electromagnetic devices, such as microwaves and cordless telephones. These objects can
disrupt radio signals.

● Keep the wireless devices away from large masonry structures and other building structures.
These objects can absorb radio waves and lower signal strength.

● Position the wireless router in a central location in line of sight with the wireless products on the
network.

Advanced wireless setup

Wireless communication modes

You can use one of two wireless communication modes: infrastructure or ad-hoc.
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Infrastructure wireless
network (recommended)

The product communicates with other devices on the network through a wireless router.

Ad-hoc wireless network The product communicates directly with other wireless devices without using a wireless
router.

All devices on the ad hoc network must have the following:

● 802.11b/g compatibility

● The same SSID

● The same subnet and channel

● The same 802.11b/g security settings

Wireless security

To make your wireless network easy to distinguish from other wireless networks, use a unique
network name (SSID) for your wireless router. Your wireless router might have a default network
name, which is typically the manufacturer's name. For information on how to change the network
name, see the documentation that came with the wireless router.
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To prevent other users from accessing your network, turn on WPA or WEP data encryption.

● Wired Equivalent Privacy (WEP): WEP is the original native security mechanism in the 802.11
standard. You create a unique key containing hexadecimal or alphanumeric characters, which
other users must provide before they can access your network.

● Wi-Fi Protected Access (WPA): WPA uses the temporal key integrity protocol (TKIP) for
encryption and employs 802.1X authentication. It addresses all known weaknesses of WEP. You
create a unique passphrase containing a combination of letters and numbers, which other users
must provide before they can access your network.

● WPA2 provides the advanced encryption standard (AES), and is an improvement over WPA.

Install the product on an ad-hoc wireless network

You can connect the product wirelessly to a computer through a peer-to-peer (ad-hoc) installation.

NOTE: To accomplish this task, you must temporarily connect the product to the network by using a
network cable.

1. Connect the network cable to the product and to the network.

2. Wait for 60 seconds before continuing. During this time, the network recognizes the product and
assigns an IP address or host name for the product.

3. Press and hold the Resume  button for two to three seconds to print a configuration page and
a supplies status page.

4. Find the IP address on the configuration page.

5. Open a Web browser, and type the IP address into the address line. The HP Embedded Web
Server opens.

6. Click the Networking tab, and select the Wireless Configuration link from the left pane.

7. Select the option to enable wireless networking, and then disconnect the network cable.

8. In the Configuration Method area, select the Create a new Ad hoc wireless network (peer-
to-peer) option.

9. Provide a unique network name, select a channel, and select the type of security to use.

10. Click the Apply button.

Configure network settings

View or change network settings

Use the embedded Web server to view or change IP configuration settings.

1. Print a configuration page, and locate the IP address.

● If you are using IPv4, the IP address contains only digits. It has this format:

xxx.xxx.xxx.xxx

● If you are using IPv6, the IP address is a hexadecimal combination of characters and digits.
It has a format similar to this:
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xxxx::xxxx:xxxx:xxxx:xxxx

2. To open the HP Embedded Web Server, type the IP address (IPv4) into the address line of a
Web browser. For IPv6, use the protocol established by the Web browser for entering IPv6
addresses.

3. Click the Networking tab to obtain network information. You can change settings as needed.
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5 Paper and print media

● Understand paper use

● Change the printer driver to match the paper type and size

● Supported paper sizes

● Supported paper types

● Load paper trays
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Understand paper use
This product supports a variety of paper and other print media in accordance with the guidelines in
this user guide. Paper or print media that does not meet these guidelines might cause poor print
quality, increased jams, and premature wear on the product.

For best results, use only HP-brand paper and print media designed for laser printers or multiuse. Do
not use paper or print media made for inkjet printers. Hewlett-Packard Company cannot recommend
the use of other brands of media because HP cannot control their quality.

It is possible for paper to meet all of the guidelines in this user guide and still not produce satisfactory
results. This might be the result of improper handling, unacceptable temperature and/or humidity
levels, or other variables over which Hewlett-Packard has no control.

CAUTION: Using paper or print media that does not meet Hewlett-Packard's specifications might
cause problems for the product, requiring repair. This repair is not covered by the Hewlett-Packard
warranty or service agreements.

Special paper guidelines

This product supports printing on special media. Use the following guidelines to obtain satisfactory
results. When using special paper or print media, be sure to set the type and size in the printer driver
to obtain the best results.

CAUTION: HP LaserJet products use fusers to bond dry toner particles to the paper in very precise
dots. HP laser paper is designed to withstand this extreme heat. Using inkjet paper could damage the
product.

Media type Do Do not

Envelopes ● Store envelopes flat.

● Use envelopes where the seam
extends all the way to the corner
of the envelope.

● Use peel-off adhesive strips that
are approved for use in laser
printers.

● Do not use envelopes that are
wrinkled, nicked, stuck together, or
otherwise damaged.

● Do not use envelopes that have
clasps, snaps, windows, or coated
linings.

● Do not use self-stick adhesives or
other synthetic materials.

Labels ● Use only labels that have no
exposed backing between them.

● Use labels that lie flat.

● Use only full sheets of labels.

● Do not use labels that have
wrinkles or bubbles, or are
damaged.

● Do not print partial sheets of
labels.

Transparencies ● Use only transparencies that are
approved for use in color laser
printers.

● Place transparencies on a flat
surface after removing them from
the product.

● Do not use transparent print media
not approved for laser printers.

Letterhead or preprinted forms ● Use only letterhead or forms
approved for use in laser printers.

● Do not use raised or metallic
letterhead.
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Media type Do Do not

Heavy paper ● Use only heavy paper that is
approved for use in laser printers
and meets the weight
specifications for this product.

● Do not use paper that is heavier
than the recommended media
specification for this product
unless it is HP paper that has
been approved for use in this
product.

Glossy or coated paper ● Use only glossy or coated paper
that is approved for use in laser
printers.

● Do not use glossy or coated paper
designed for use in inkjet products.
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Change the printer driver to match the paper type and
size

NOTE: If you change the page settings in the software program, those settings override any
settings in the printer driver.

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Select a size from the Size is drop-down list.

5. Select a paper type from the Type is drop-down list.

6. Click the OK button.
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Supported paper sizes
This product supports various paper sizes, and it adapts to various media.

NOTE: To obtain best print results, select the appropriate paper size and type in your print driver
before printing.

Table 5-1  Supported paper and print media sizes

Size Dimensions

Letter 216 x 279 mm (8.5 x 11 in)

Legal 216 x 356 mm (8.5 x 14 in)

A4 210 x 297 mm (8.27 x 11.69 in)

Executive 184 x 267 mm (7.25 x 10.5 in)

8.5 x 13 216 x 330 mm (8.5 x 13 in)

4 x 6 101.6 x 152.4 mm (4 x 6 in)

10 x 15 cm 101.6 x 152.4 mm (4 x 6 in)

5 x 8 127 x 203 mm (5 x 8 in)

RA4 215 x 305 mm (8.46 x 12.01 in)

A5 148 x 210 mm (5.83 x 8.27 in)

A6 105 x 148 mm (4.13 x 5.83 in)

B5 (JIS) 182 x 257 mm (7.17 x 10.12 in)

16k 184 x 260 mm (7.24 x 10.23 in)

195 x 270 mm (7.68 x 10.62 in)

197 x 273 mm (7.75 x 10.75 in)

Custom Minimum: 76 x 127 mm (3 x 5 in)

Maximum: 216 x 356 mm (8.5 x 14.0 in)

NOTE: When defining custom sizes using the printer driver, always specify the short
edge of the page as the width and the long edge as the length.

Table 5-2  Supported envelopes and postcards

Size Dimensions

Envelope #10 105 x 241 mm (4.13 x 9.49 in)

Envelope DL 110 x 220 mm (4.33 x 8.66 in)

Envelope C5 162 x 229 mm (6.93 x 9.84 in)

Envelope B5 176 x 250 mm (6.7 x 9.8 in)

Envelope Monarch 98 x 191 mm (3.9 x 7.5 in)

Japanese Postcard

Postcard (JIS)

100 x 148 mm (3.93 x 5.82 in)
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Size Dimensions

Double Japan Postcard Rotated

Double Postcard (JIS)

148 x 200 mm (5.83 x 7.87 in)

Custom Minimum: 76 x 127 mm (3 x 5 in)

Maximum: 216 x 356 mm (8.5 x 14.0 in)

NOTE: When defining custom sizes using the printer driver, always specify the short
edge of the page as the width and the long edge as the length.

Table 5-2  Supported envelopes and postcards (continued)
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Supported paper types
For a complete list of specific HP-brand paper that this product supports, go to www.hp.com/support/
ljcp1020series.

● Everyday

◦ Plain

◦ Light

◦ Bond

◦ Recycled

● Presentation

◦ Matte paper

◦ Glossy paper

◦ Heavy paper

◦ Heavy glossy paper

● Brochure

◦ Matte paper

◦ Glossy paper

◦ Tri-fold paper

◦ Extra heavy paper

◦ Extra heavy glossy paper

● Photo/Cover

◦ Matte cover paper

◦ Matte photo paper

◦ Photo glossy paper

◦ Glossy cards

● Other

◦ Color laser transparency

◦ Labels

◦ Letterhead

◦ Envelope

◦ Heavy envelope

◦ Preprinted

◦ Prepunched
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◦ Colored

◦ Rough

◦ Heavy rough

◦ HP Tough paper
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Load paper trays

Load the input tray

NOTE: When you add new paper make sure that you remove all of the paper from the input tray
and straighten the stack of new paper. Do not fan the paper. This reduces jams by preventing
multiple sheets of paper from feeding through the product at one time.

NOTE: When printing on small sizes or custom paper, load the short edge (width) into the product
first.

1. Load the paper face-up, top forward in the
input tray.

 

2. Adjust the guides until they are snug against
the paper.
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Tray capacity

Tray or bin Paper type Specifications Capacity

Input tray Paper 60-220 g/m2 (16-59 lb)

Print quality is assured for HP
media.

150 sheets of 75 g/m2 (20 lb)

Envelopes 60-90 g/m2 (16-24 lb) Up to 10 envelopes

Transparencies 0.12-0.13 mm (0.0047-.0.0051
in)

Up to 50 transparencies

Postcards 135-176 g/m2 (36-47 lb)

Glossy 130-220 g/m2 (35-59 lb)

Paper orientation for loading trays

If you are using paper that requires a specific orientation, load it according to the information in the
following table.

Paper type How to load paper

Preprinted or letterhead ● Face up

● Top edge leading into the product

Prepunched ● Face up

● Holes toward the left side of the product

Envelope ● Face up

● Right short edge leading into the product
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6 Print tasks

● Cancel a print job with Windows

● Basic print tasks with Windows

● Additional print tasks with Windows
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Cancel a print job with Windows
1. If the print job is currently printing, cancel it by pressing the Cancel  button on the product

control panel.

NOTE: Pressing the Cancel  button clears the job that the product is currently processing. If
more than one process is running, pressing the Cancel  button clears the process that
currently appears on the product control panel.

2. You can also cancel a print job from a software program or a print queue.

● Software program: Typically, a dialog box appears briefly on the computer screen,
allowing you to cancel the print job.

● Windows print queue: If a print job is waiting in a print queue (computer memory) or print
spooler, delete the job there.

◦ Windows XP, Server 2003, or Server 2008: Click Start, click Settings, and then click
Printers and Faxes. Double-click the product icon to open the window, right-click the
print job that you want to cancel, and then click Cancel.

◦ Windows Vista: Click Start, click Control Panel, and then, under Hardware and
Sound, click Printer. Double-click the product icon to open the window, right-click the
print job that you want to cancel, and then click Cancel.

◦ Windows 7: Click Start, and then click Devices and Printers. Double-click the
product icon to open the window, right-click the print job that you want to cancel, and
then click Cancel.
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Basic print tasks with Windows
The methods to open the print dialog from software programs can vary. The procedures that follow
include a typical method. Some software programs do not have a File menu. See the documentation
for your software program to learn how to open the print dialog.

Open the printer driver with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.

 

Get help for any printing option with Windows

1. Click the Help button to open the online Help.  
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Change the number of print copies with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then select the number of copies.

Save custom print settings for reuse with Windows

Use a printing shortcut with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Printing Shortcuts tab.  

4. Select one of the shortcuts, and then click the
OK button.

NOTE: When you select a shortcut, the
corresponding settings change on the other
tabs in the printer driver.

 

Create printing shortcuts

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Printing Shortcuts tab.  

4. Select an existing shortcut as a base.

NOTE: Always select a shortcut before
adjusting any of the settings on the right side
of the screen. If you adjust the settings and
then select a shortcut, or if you select a
different shortcut, all your adjustments are
lost.
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5. Select the print options for the new shortcut.

NOTE: You can select the print options on
this tab or on any other tab in the printer
driver. After selecting options on other tabs,
return to the Printing Shortcuts tab before
continuing with the next step.

 

6. Click the Save As button.  

7. Type a name for the shortcut, and click the
OK button.

 

Improve print quality with Windows

Select the page size with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Select a size from the Size is drop-down list.
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Select a custom page size with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Click the Custom button.

5. Type a name for the custom size and specify the dimensions.

● The width is the short edge of the paper.

● The length is the long edge of the paper.

NOTE: Always load paper into the trays short edge first.

6. Click the Save button, and then click the Close button.

Select the paper type with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. From the Type is drop-down list, click the More... option.

5. Select the category of paper types that best describes your paper, and then click the paper type
that you are using.

Print on both sides (duplex) with Windows

Print on both sides manually

1. Load paper face-up in the input tray.  
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2. On the File menu in the software program,
click Print.

 

3. Select the product, and then click the
Properties or Preferences button.

 

4. Click the Finishing tab.  
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5. Select the Print on Both Sides (Manually)
check box. Click the OK button to print the
first side of the job.

 

6. Retrieve the printed stack from the output bin,
and, maintaining the paper orientation, place
it with the printed-side facing down in the
input tray.

 

7. At the computer, click the Continue button to
print the second side of the job. If at the
product, press the Resume  button.

 

Print multiple pages per sheet with Windows

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  
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4. Select the number of pages per sheet from
the Pages Per Sheet drop-down list.

 

5. Select the correct Print Page Borders, Page
Order, and Orientation options.

 

Select page orientation with Windows

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Finishing tab.  

4. In the Orientation area, select the Portrait or
Landscape option.

To print the page image upside down, select
the Rotated option.
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Set color options with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Color tab.

4. In the Color Options area, click the Manual option, and then click the Settings button.

5. Adjust the general settings for Edge Control, and settings for text, graphics, and photographs.
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Additional print tasks with Windows

Print colored text as black (grayscale) with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. Click the Print all Text as Black check box. Click the OK button.
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Print on preprinted letterhead or forms with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Paper/Quality tab.  

58 Chapter 6   Print tasks ENWW



4. From the Type is drop-down list, click the
More... option.

 

5. Select the Other option.  

6. Select the option for the type of paper you are
using, and click the OK button.
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Print on special paper, labels, or transparencies with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Paper/Quality tab.  
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4. From the Type is drop-down list, click the
More... option.

 

5. Select the category of paper types that best
describes your paper.

NOTE: Labels and transparencies are in the
list of Other options.

 

6. Select the option for the type of paper you are
using, and click the OK button.
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Print the first or last page on different paper with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Paper/Quality tab.  

4. Click the Use different paper check box, and
then select the necessary settings for the
front cover, other pages, and back cover.

 

Scale a document to fit page size with Windows

1. On the File menu in the software program,
click Print.
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2. Select the product, and then click the
Properties or Preferences button.

 

3. Click the Effects tab.  

4. Select the Print Document On option, and
then select a size from the drop-down list.
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Add a watermark to a document with Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Effects tab.

4. Select a watermark from the Watermarks drop-down list.

Or, to add a new watermark to the list, click the Edit button. Specify the settings for the
watermark, and then click the OK button.

5. To print the watermark on the first page only, select the First Page Only check box. Otherwise,
the watermark is printed on each page.

Create a booklet with Windows

1. On the File menu in the software program,
click Print.

 

2. Select the product, and then click the
Properties or Preferences button.
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3. Click the Finishing tab.  

4. Click the Print on Both Sides (Manually)
check box.

 

5. In the Booklet Printing drop-down list, select
a binding option. The Pages Per Sheet
option automatically changes to 2 Pages Per
Sheet.
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7 Color

● Adjust color

● Match colors
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Adjust color
Manage color by changing the settings on the Color tab in the printer driver.

Change the color theme for a print job

1. On the File menu in the software program, click Print.

2. Click Properties or Preferences.

3. Click the Color tab.

4. Select a color theme from the Color Themes drop-down list.

● Default (sRGB): This theme sets the product to print RGB data in raw device mode. When
using this theme, manage color in the software program or in the operating system for
correct rendering.

● Vivid: The product increases the color saturation in the midtones. Use this theme when
printing business graphics.

● Photo: The product interprets RGB color as if it were printed as a photograph using a
digital mini lab. The product renders deeper, more saturated colors differently than with the
Default (sRBG) theme. Use this theme when printing photos.

● Photo (Adobe RGB 1998): Use this theme with printing digital photos that use the
AdobeRGB color space rather than sRGB. Turn off color management in the software
program when using this theme.

● None: No color theme is used.

Change the color options

Change the color options settings for the current print job from the color tab of the printer driver.

1. On the File menu in the software program, click Print.

2. Click Properties or Preferences.

3. Click the Color tab.
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4. Click the Automatic or Manual setting.

● Automatic setting: Select this setting for most color print jobs

● Manual setting: Select this setting to adjust the color settings independent from other
settings.

NOTE: Changing color settings manually can impact output. HP recommends that only
color graphics experts change these settings.

5. Click the Print in Grayscale option to print a color document in black and shades of gray. Use
this option to print color documents for photocopying or faxing. You can also use this option to
print draft copies or to save color toner.

6. Click the OK button.

Manual color options

Use manual color options to adjust the Neutral Grays, Halftone, and Edge Control options for text,
graphics, and photographs.

Table 7-1  Manual color options

Setting description Setting options

Edge Control

The Edge Control setting determines the rendering
of edges. Edge control has two components:
adaptive halftoning and trapping. Adaptive
halftoning increases edge sharpness. Trapping
reduces the effect of color-plane misregistration by
overlapping the edges of adjacent objects slightly.

● Off turns off both trapping and adaptive halftoning.

● Light sets trapping at a minimal level. Adaptive halftoning is on.

● Normal sets trapping at a medium level. Adaptive halftoning is
on.

● Maximum is the most aggressive trapping setting. Adaptive
halftoning is on.
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Setting description Setting options

Halftone

Halftone options affect color output clarity and
resolution.

● Smooth provides better results for large, solid-filled print areas
and enhances photographs by smoothing color gradations.
Select this option when uniform and smooth area fills are
important.

● Detail is useful for text and graphics that require sharp
distinctions among lines or colors, or images that contain a
pattern or a high level of detail. Select this option when sharp
edges and small details are important.

Neutral Grays

The Neutral Grays setting determines the method
for creating gray colors used in text, graphics, and
photographs.

● Black Only generates neutral colors (grays and black) by using
only black toner. This guarantees neutral colors without a color
cast. This setting is best for documents and grayscale
viewgraphs.

● 4-Color generates neutral colors (grays and black) by combining
all four toner colors. This method produces smoother gradients
and transitions to other colors, and it produces the darkest black.

Table 7-1  Manual color options (continued)
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Match colors
For most users, the best method for matching colors is to print sRGB colors.

The process of matching printer output color to your computer screen is complex, because printers
and computer monitors use different methods of producing color. Monitors display colors by using
light pixels that use an RGB (red, green, blue) color process, but printers print colors by using a
CMYK (cyan, magenta, yellow, and black) process.

Several factors can influence your ability to match printed colors to those on your monitor:

● Print media

● Printer colorants (inks or toners, for example)

● Printing process (inkjet, press, or laser technology, for example)

● Overhead lighting

● Personal differences in perception of color

● Software programs

● Printer drivers

● Computer operating systems

● Monitors

● Video cards and drivers

● Operating environment (humidity, for example)

Keep these factors in mind when colors on your screen do not perfectly match your printed colors.
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8 Manage and maintain the product

● Print information pages

● Use the HP Embedded Web Server (network models only)

● Product security features

● Economy settings

● Manage supplies and accessories

● Clean the product

● Product updates
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Print information pages
You can print the following information pages.

Page Description

Configuration page Prints a list of the product settings

Supplies Status page The supplies status page includes the following information:

● Approximate percentage of print cartridge life remaining

● Warranty status of print cartridges and imaging drum

● Part numbers for HP print cartridges

● Number of pages printed

● Information about ordering new HP print cartridges and
recycling used HP print cartridges

● The imaging drum's estimated life remaining and
installation date display if less than 30% of its estimated
life remains.

Print the configuration page

The configuration page lists current product settings and properties. This page also contains a status
log report. To print a configuration page, do one of the following:

● Select Print configuration page on the Services tab in the Printer Preferences.

● Press and hold the Resume  button for two to three seconds to print a configuration page and
a supplies status page (English only).

Print the supplies status page

To print a supplies status page, do one of the following:

● Select Print supplies status page on the Services tab in the Printer Preferences.

● Press and hold the Resume  button for two to three seconds to print a configuration page and
a supplies status page (English only).
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Use the HP Embedded Web Server (network models only) 

This product is equipped with an embedded Web server (EWS), which provides access to information
about product and network activities. A Web server provides an environment in which web programs
may run, much in the same way that an operating system, such as Windows, provides an
environment for programs to run on a computer. The output from these programs can then be
displayed by a Web browser, such as Microsoft Internet Explorer, Safari, or Netscape Navigator.

An “embedded” Web server resides on a hardware device (such as an HP LaserJet product) or in
firmware, rather than as software that is loaded on a network server.

The advantage of an EWS is that it provides an interface to the product that anyone with a network-
connected product and computer can use. There is no special software to install or configure, but you
must have a supported Web browser on the computer. To gain access to the EWS, type the IP
address for the product in the address line of the browser. To find the IP address, print a configuration
page.

NOTE: For Mac operating systems, you can use the EWS over a USB connection after installing the
Mac software included with the product.

Open the HP Embedded Web Server

To open the HP Embedded Web Server, type the IP address or host name of the product in the
address field of a supported Web browser. To find the IP address, print a configuration page. Select
Print configuration page on the Services tab in the Printer Preferences.

TIP: After you open the URL, bookmark it so that you can return to it quickly in the future.

HP Embedded Web Server features

The table below describes the basic screens of the embedded Web server.
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Tab or section Description

Status tab

Provides product, status, and
configuration information.

● Device Status: Shows the product status and shows the life remaining of
HP supplies, with 0% indicating that a supply is empty.

● Supplies Status: Shows the approximate percent life remaining of HP supplies.
When the estimated life remaining is less than 10% but has not reached the
estimated end of life, Less Than 10% displays. When a supply reaches its
estimated end of life –% displays. Actual supply life remaining can vary. Consider
having a replacement supply available to install when print quality is no longer
acceptable. The supply does not need to be replaced unless the print quality is no
longer acceptable. When an HP supply has reached “Very Low”, HP’s Premium
Protection Warranty on that supply ends.

The imaging drum's estimated remaining life and installation date displays when
less than approximately 30% of its estimated life remains.

● Device Configuration: Shows the information found on the product Configuration
page.

● Network Summary: Shows the information found on the product Network
Configuration page.

● Reports: Allows you to print the configuration and supplies status pages that the
product generates.

● Event Log: Shows a list of all product events and errors.

● Support button: Provides a link to the product support page. The Support button
can be password-protected.

● Shop for Supplies button: Provides a link to a page where you can order supplies
for the product. The Shop for Supplies button can be password-protected.

System tab

Provides the ability to configure
the product from your computer.

● Paper Setup: Allows you to change the paper-handling defaults for the product.

● Print Quality: Allows you to change the print quality defaults for the product,
including calibration settings.

● Print Density: Allows you to change the contrasts, highlights, midtones, and
shadows values for each supply.

● Paper Types: Allows you to configure print modes that correspond to the media
types that the product accepts.

● System Setup: Allows you to change the system defaults for the product.

● Service: Allows you to start the cleaning procedure on the product.

● Product Security: Allows you to set or change the Administrator password.

● Support button: Provides a link to the product support page. The Support button
can be password-protected.

● Shop for Supplies button: Provides a link to a page where you can order supplies
for the product. The Shop for Supplies button can be password-protected.

NOTE: The System tab can be password-protected. If this product is on a network,
always consult with the printer administrator before changing settings on this tab.

Networking tab

Provides the ability to change
network settings from your
computer.

Network administrators can use this tab to control network-related settings for the
product when it is connected to an IP-based network. This tab does not appear if the
product is directly connected to a computer.
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Product security features
The product supports security standards and recommended protocols that help you keep the product
secure, protect critical information on your network, and simplify the way you monitor and maintain
the product.

For in-depth information about HP's secure imaging and printing solutions, visit www.hp.com/go/
secureprinting. The site provides links to white papers and FAQ documents about security features.

Lock the product

1. You can attach a security cable to the slot on
the back of the product.

 

Assign a system password

Assign a password for the product so that unauthorized users cannot change the product settings.

1. Open the HP Embedded Web Server by entering the product IP address into the address line of
a Web browser.

2. Click the System tab.

3. On the left side of the window, click the Product Security menu.

4. Type the password in the Password box, and type it again in the Confirm Password box.

5. Click the Apply button. Make note of the password and store it in a safe place.
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Economy settings

Set Auto-On/Auto-Off mode

Auto-On\Auto-Off is an energy-saving feature of this product. After a user-specified time period, the
product automatically reduces its power consumption. The product returns to the ready state when a
button is pressed or a print job is received.

NOTE: Although the product lights are off in Auto-Off mode, the product will work normally when it
receives a print job.

Change the Auto-On\Auto-Off setting

You can change how long the product remains idle (Auto-Off delay) before it enters Auto-Off mode.
You can also select which events cause the product to turn on.

1. In the Windows system tray, right-click the Device Settings  icon and then click the product
name.

2. Click the Device Settings button.

3. Click the AutoOFF after delay button, and then select the Auto-Off delay from the drop-down
list.

4. Under AutoON to these events click the desired events (optional).
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Manage supplies and accessories
Correctly using, storing, and monitoring the print cartridge and imaging drum can help ensure high-
quality print output.

Print when a print cartridge or imaging drum is at estimated end of life

Supplies messages

<Supply> Low message—where <Supply> is the color print cartridge: The product indicates when a
supply level is low. Actual print cartridge life remaining may vary. Consider having a replacement
available to install when print quality is no longer acceptable. The supply does not need to be
replaced now. This alert appears only when <Supply> Very Low is set to Stop.

<Supply> Very Low message—where <Supply> is either the color print cartridge or imaging drum or
a combination of multiple print cartridges and/or the imaging drum: The product indicates when a
supply level is very low. Actual print cartridge life remaining may vary. Consider having a replacement
available to install when print quality is no longer acceptable. Print-quality problems may occur when
using a supply that is at its estimated end of life. The supply does not need to be replaced now unless
the print quality is no longer acceptable.

Once an HP print cartridge has reached “Very Low”, HP’s Premium Protection Warranty on that print
cartridge has ended. HP’s Premium Protection Warranty applies only to the print cartridge for this
product.

The imaging drum installed in this product is covered by the product warranty. Replacement imaging
drums have a one year limited warranty from the date of installation. The imaging drum installation
date displays on both the configuration page and on the supplies status page when the imaging drum
reaches approximately 30% of its estimated remaining life.

Enable or disable the At Very Low settings

You can change the default settings at any time and do not need to re-enable the settings when a
new print cartridge is installed. The <Supply> Very Low alert message displays when a print
cartridge is set to Continue At Very Low. Once an HP print cartridge has reached “Very Low”, HP’s
Premium Protection Warranty on that cartridge has ended.

1. In the Windows system tray, right-click the Device Settings  icon and then click the product
name.

2. Click the System Setup tab.

3. From the At Very Low drop-down list, select one of the following options:

● Select the Continue option set the product to alert you that the print cartridge is very low,
but to continue printing.

● Select the Stop option to set the product to alert you and stop printing until you replace the
print cartridge.

● Select the Prompt (the default) option to set the product to stop printing and prompt you to
replace the print cartridge. You can acknowledge the prompt and continue printing.
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Manage print cartridges and imaging drums

Print-cartridge and imaging drum storage

Do not remove the print cartridge or imaging drum from their packages until you are ready to use
them.

HP policy on non-HP supplies

Hewlett-Packard Company cannot recommend the use of non-HP print cartridges and imaging
drums, either new or remanufactured.

NOTE: Non-HP Laser Print Cartridge Use

For HP printer products, the use of a non-HP toner cartridge or imaging drum, or a refilled toner
cartridge, does not affect either the warranty to the customer or any HP support contract with the
customer. However, if product failure or damage is attributable to the use of a non-HP or refilled toner
cartridge, HP will charge its standard time and materials charges to service the product for the
particular failure or damage.

HP fraud hotline and Web site

Call the HP fraud hotline (1-877-219-3183, toll-free in North America) or go to www.hp.com/go/
anticounterfeit when you install an HP print cartridge and the supplies status page message says the
cartridge is non-HP or used. HP will help determine if the cartridge is genuine and take steps to
resolve the problem.

Your print cartridge might not be a genuine HP print cartridge if you notice the following:

● The supplies status page indicates that a non-HP supply is installed.

● You are experiencing a high number of problems with the print cartridge.

● The cartridge does not look like it usually does (for example, the packaging differs from
HP packaging).

Recycle supplies

To recycle a genuine HP print cartridge or imaging drum, place the used supply in the box in which
the supply arrived. Use the enclosed return label to send the used supply to HP for recycling. For
complete information, see the recycling guide that is included with each new HP supply item.

Print cartridge layout

1

2
1 Print cartridge E-label

2 Plastic shield
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Imaging drum layout

1 2

1 Imaging drum E-label

2 Plastic shield
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Replacement instructions

Replace the print cartridges

When a print cartridge approaches the end of its useful life, you can continue printing with the current
print cartridge until it no longer yields acceptable print quality.

Once an HP print cartridge has reached “very low”, HP’s Premium Protection Warranty on that supply
has ended. All print defects or print cartridge failures incurred when an HP supply is used in continue
at very low mode will not be considered to be defects in materials or workmanship in the supply under
the HP Print Cartridge Warranty Statement.

NOTE: Once an HP print cartridge has reached “very low”, the corresponding cartridge light on the
control panel turns on.

1. Press the Cartridge  button of the print
cartridge that requires replacement to rotate
the print cartridge carousel for removal.

NOTE: All doors must be closed when
pressing the Cartridge  button.

NOTE: Wait until the Cartridge  light is
not flashing and the rotation sounds stops
before opening the print cartridge door.

 

2. Open the print cartridge door.  
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3. Grasp the old print cartridge by the center
handle and remove.

 

4. Remove the new print cartridge from the
packaging. Place the used print cartridge in
the bag and box for recycling.

CAUTION: To prevent damage to the print
cartridge, hold the print cartridge at each end.
Do not touch the roller on the print cartridge.

 

5. Grasp both sides of the print cartridge and
gently rock the print cartridge to distribute the
toner evenly inside the print cartridge.

 

6. Remove the tape from the print cartridge.
Place the tape in the print-cartridge box to
return for recycling.

 

ENWW Manage supplies and accessories 83



7. Remove the protective shielding from the new
print cartridge.

 

8. Grasp the print cartridge by the center handle
and insert into the product.

NOTE: Compare the color label on the print
cartridge to the color label in the carousel slot
to make sure the print cartridge color matches
the carousel position.

CAUTION: If toner gets on your clothing,
wipe it off with a dry cloth and wash the
clothing in cold water. Hot water sets toner
into the fabric.
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9. Close the print cartridge door.

NOTE: After closing the print cartridge door,
the Ready  light and Attention  light will
flash. Allow up to three minutes for the
product to calibrate.

NOTE: If replacing another print cartridge,
you must close the print cartridge door before
pressing the Cartridge  button of the next
print cartridge.

You do not need to wait for the product to
calibrate when replacing the second print
cartridge. Instead, press the Cartridge 
button for the next color to rotate the carousel
into position. After you have replaced the print
cartridges, the product calibrates.

NOTE: After every other black cartridge
change, a cleaning page prints automatically
to clean the fuser. This cleaning page process
takes two minutes to complete.

 

10. When printing, if you receive the status alert
message Wrong Cartridge in <Color> Slot,
remove the print cartridge from the specified
slot and compare the color label on the print
cartridge to the color label in the slot to
determine the correct print cartridge for the
slot.
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Replace the imaging drum

NOTE: The imaging drum installed in this product is covered by the product warranty. Replacement
imaging drums have a one-year limited warranty from the date of installation. The imaging drum
installation date displays on both the configuration page and on the supplies status page when the
imaging drum reaches approximately 30% of its estimated remaining life. HP's Premium Protection
Warranty applies only to the print cartridges for the product.

1. Open the print cartridge door.  

2. Open the front cover.  
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3. Lift the two levers that hold the imaging drum.  

4. Remove the old imaging drum.  

5. Remove the new imaging drum from the
packaging. Place the used imaging drum in
the bag and box for recycling.
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6. Remove the protective shielding from the new
imaging drum.

CAUTION: To prevent damage, do not
expose the imaging drum to light. Cover it
with a piece of paper.

CAUTION: Do not touch the green roller.
Fingerprints on the imaging drum can cause
print-quality problems.

 

7. Insert the new imaging drum in the product.  

8. Lower the two levers that hold the imaging
drum.
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9. Close the front cover.  

10. Close the print cartridge door.

NOTE: After closing the print cartridge door,
the Ready  light and Attention  light will
flash. Allow up to three minutes for the
product to calibrate.
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Clean the product

Clean the paper path

If you are experiencing toner specks or dots on the printouts, clean the paper path. This process uses
a transparency to remove dust and toner from the paper path. Do not use bond or rough paper.

NOTE: For best results use a sheet of LaserJet transparency. If you do not have any
transparencies, you can use copier-grade media (60 to 163 g/m2 (16 to 43 lb)) that has a smooth
surface.

1. Make sure that the product is idle and the Ready  light is on.

2. Load paper in the input tray.

3. In the Windows system tray, right-click the Device Settings  icon and then click the product
name.

4. Click the Device Settings tab.

5. Click the Print Cleaning Page button.

NOTE: The cleaning process takes about 2 minutes. The cleaning page stops periodically during
the cleaning process. Do not turn the product off until the cleaning process has finished. You might
need to repeat the cleaning process several times to thoroughly clean the product.

Clean the exterior

Use a soft, damp, lint-free cloth to wipe dust, smudges, and stains off of the exterior of the device.

Product updates
Software and firmware updates and installation instructions for this product are available at
www.hp.com/support/ljcp1020series. Click Downloads and drivers, click the operating system, and
then select the download for the product.
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9 Solve problems

● Self help

● Solve problems checklist

● Factors that affect product performance

● Restore factory settings

● Interpret control panel light patterns

● Status alert messages

● Paper feeds incorrectly or becomes jammed

● Improve print quality

● The product does not print or it prints slowly

● Solve connectivity problems

● Solve wireless network problems

● Solve product software problems

● Solve common Mac problems
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Self help
In addition to the information in this guide, other sources are available that provide helpful
information.

HP Help and Learn Center The HP Help and Learn Center and other documentation are on the CD that came
with the product or in the HP Program folder on your computer. The HP Help and
Learn Center is a product help tool that provides easy access to product
information, HP product Web support, troubleshooting, and regulatory and safety
information.

Quick Reference Topics Several Quick Reference Topics for this product are available at this Web site:
www.hp.com/support/ljcp1020series

You can print these topics and keep them near the product. They are a handy
reference for procedures that you perform frequently.
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Solve problems checklist
Follow these steps when trying to solve a problem with the product.

● Step 1: Make sure that the product is set up correctly

● Step 2: Check the cabling or wireless connection (network models only)

● Step 3: Check to see if any control-panel lights are lit

● Step 4: Check the paper

● Step 5: Check the software

● Step 6: Test print functionality

● Step 7: Check the supplies

● Step 8: Try sending a print job from a computer

Step 1: Make sure that the product is set up correctly

Make sure that the product is set up correctly.

1. Press the power button to turn on the product or to deactivate the Auto-On\Auto-Off mode.

2. Check the power-cable connections.

3. Make sure that the line voltage is correct for the product power configuration. (See the label that
is on the back of the product for voltage requirements.) If you are using a power strip and its
voltage is not within specifications, plug the product directly into the wall. If it is already plugged
into the wall, try a different outlet.

4. Make sure that the print cartridge is installed correctly.

5. If none of these measures restores power, contact HP Customer Care.

Step 2: Check the cabling or wireless connection (network models only)

1. Check the cable connection between the product and the computer. Make sure that the
connection is secure.

2. Make sure that the cable itself is not faulty by using a different cable, if possible.

Step 3: Check to see if any control-panel lights are lit

The control panel should indicate ready status. If an error message appears, resolve the error.

Step 4: Check the paper

1. Make sure that the paper that you are using meets specifications.

2. Make sure that the paper is loaded correctly in the input tray.
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Step 5: Check the software

1. Make sure that the product software is installed correctly.

2. Verify that you have installed the printer driver for this product. Check the program to make sure
that you are using the printer driver for this product.

Step 6: Test print functionality

1. Print a configuration page. Select Print configuration page on the Services tab in the Printer
Preferences.

2. If the page does not print, verify that the input tray contains paper.

3. If the page jams in the product, clear the jam.

Step 7: Check the supplies

Print a supplies status page and check the estimated remaining life of the print cartridges and
imaging drum.

Step 8: Try sending a print job from a computer

1. Try printing the job from another computer that has the product software installed.

2. Check the USB cable connection. Direct the product to the correct port, or reinstall the software,
selecting the connection type that you are using.

3. If the print quality is unacceptable, complete the following steps:

● Verify that the print settings are correct for the media that you are using.
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Factors that affect product performance
Several factors affect the time it takes to print a job:

● The use of special paper (such as transparencies, heavy paper, and custom-size paper)

● Product processing and download time

● The complexity and size of graphics

● The speed of the computer you are using

● The USB or network connection

● The product I/O configuration
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Restore factory settings
Restoring the factory-set defaults returns most of the settings to the factory defaults. It will not reset
the page count, tray size, or language. To restore the product to the factory-default settings, follow
these steps.

1. Turn the product off. Disconnect the power cable from the product for 30 seconds and then
reconnect.

2. Turn the product on while you press and hold the Resume  button for 10-20 seconds. The
Attention  light turns on.

3. Release the Resume  button. The Attention  and Ready  lights cycle while the product
restores factory defaults.
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Interpret control panel light patterns
Table 9-1  Status light legend

Symbol for "light off"

Symbol for "light on"

Symbol for "light blinking"

Table 9-2  Control-panel light patterns

Light status State of the product Action

All lights are off. The product is turned off. Press the power button to turn on the
product.

The Auto-On/Auto-Off feature has
turned off the product.

No action is required.

The attention and ready lights are
cycling.

The lights cycle during the formatter
initialization period or when the product
is processing a cleaning page.

No action is required. Wait for the
initialization period to end. The product
should enter the ready state when the
initialization period is finished.

Ready light is on. The product is in the ready state. No action is required. The product is
ready to receive a print job.

Ready light blinks. The product is receiving or processing
data.

No action is required. The product is
receiving or processing a print job.
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Light status State of the product Action

Attention light blinks. Ready light is on. The product is in manual-feed mode. Load the correct paper type and size
into the input tray.

The product is waiting to print the
second side of a manual duplex print
job.

Load the input tray with the paper from
the output bin.

Attention light blinks. The input tray is empty. Load the tray.

Paper is jammed in the product. Clear the jam.

Attention and ready lights are on. The product has experienced a fatal
error from which it cannot recover.

1. Turn off the product and
disconnect the power cable from
the product.

2. Wait 30 seconds and then
reconnect the power cord and turn
on the product.

3. Wait for the product to initialize.

If the error persists, contact
HP customer support.

Attention and ready lights blink. Paper is jammed in the product. Clear the jam.

Cartridge light blinks. The print cartridge has rotated and is
now accessible.

Access the print cartridge.

The print cartridge is missing or is not
installed correctly.

Install the print cartridge.

Table 9-2  Control-panel light patterns (continued)
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Light status State of the product Action

Cartridge and attention lights blink. The print cartridge is very low and has
reached the end of its estimated useful
life. When the supply has reached this
condition, the HP Premium Protection
warranty for that supply has ended.

You do not need to replace the print
cartridge at this time unless print quality
is no longer acceptable. Press the
Resume  button to continue.

A non-HP print cartridge in use. You do not need to replace the print
cartridge at this time unless print quality
is no longer acceptable. Press the
Resume  button to continue.

Print cartridge is rotating. No action is required. Wait for the
rotation period to end. The product
should enter the previous state when
the rotation period is finished.

Cartridge and ready lights are on. The print cartridge has reached the end
of its estimated useful life. When the
supply has reached this condition, the
HP Premium Protection warranty for that
supply has ended.

You do not need to replace the print
cartridge at this time unless print quality
is no longer acceptable.

Non-HP print cartridge in use and is very
low.

No action is required.

Table 9-3  Wireless light patterns

Light status State of the product Action

Wireless light is off. The wireless connection is turned off. Press and hold the Wireless  button
for 2 seconds to turn on the WPS.

The Ethernet is connected. No action is required.

Wireless light blinks. The product is trying to establish a
wireless connection.

No action is required.

There is a WPS error. Attempt to connect again.

Wireless light is on. The product has established a wireless
connection.

No action is required.  

Table 9-2  Control-panel light patterns (continued)
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Status alert messages
Status alert messages appear on the computer screen when the product has certain problems. Use
the information in the following table to solve these problems.

Alert message Description Recommended action

Black Cartridge Low The print cartridge is nearing the estimated
end of its useful life.

The product indicates when a print cartridge
level is low. Actual cartridge life remaining
may vary. Consider having a replacement
available to install when print quality is no
longer acceptable. The print cartridge does
not need to be replaced now.

This alert displays only if the product is
customer configured to stop when the print
cartridge reaches the “very low” threshold.

Black Cartridge Very Low The print cartridge is at the estimated end of
its useful life.

Print quality may decrease. Choose a
reminder option or replace print cartridge
when quality becomes unacceptable.

To ensure optimal print quality, HP
recommends replacing the print cartridge at
this point. You do not need to replace the
print cartridge at this time unless print
quality is no longer acceptable. Actual print
cartridge life may vary.

Once an HP print cartridge has reached
“very low”, HP's Premium Protection
Warranty on that print cartridge has ended.
All print defects or cartridge failures incurred
when an HP supply is used in continue at
very low mode will not be considered to be
defects in materials or workmanship in the
supply under the HP Print Cartridge
Warranty Statement.

Calibrating The product is performing the internal
calibration process to ensure the best
possible print quality.

Wait for the process to complete.

Cartridge Memory Error on <Color> The e-label for one of the print cartridges
cannot be read or is missing.

● Reinstall the print cartridge.

● Turn off the product and disconnect the
power cable from the product. Wait
30 seconds and then reconnect the
power cord and turn on the product.

● If the problem is not solved, replace
the cartridge.

Cool Down Mode After prolonged, continuous operation, or
after printing on narrow paper, the product
must pause to cool.

Printing will continue when the product has
cooled.

Cyan Cartridge Low The print cartridge is nearing the estimated
end of its useful life.

The product indicates when a print cartridge
level is low. Actual cartridge life remaining
may vary. Consider having a replacement
available to install when print quality is no
longer acceptable. The print cartridge does
not need to be replaced now.

This alert displays only if the product is
customer configured to stop when the print
cartridge reaches the “very low” threshold.
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Alert message Description Recommended action

Cyan Cartridge Very Low The print cartridge is at the estimated end of
its useful life.

Print quality may decrease. Choose a
reminder option or replace print cartridge
when quality becomes unacceptable.

To ensure optimal print quality, HP
recommends replacing the print cartridge at
this point. You do not need to replace the
print cartridge at this time unless print
quality is no longer acceptable. Actual print
cartridge life may vary.

Once an HP print cartridge has reached
“very low”, HP's Premium Protection
Warranty on that print cartridge has ended.
All print defects or cartridge failures incurred
when an HP supply is used in continue at
very low mode will not be considered to be
defects in materials or workmanship in the
supply under the HP Print Cartridge
Warranty Statement.

DC Controller Error The product has experienced an internal
error.

Turn off the product and disconnect the
power cable from the product. Wait
30 seconds and then reconnect the power
cord and turn on the product. Wait for the
product to initialize.

If you are using a surge protector, remove it.
Plug the product directly into the wall
socket. Use the power switch to turn on the
product.

If the message persists, contact HP support.

Engine Communication Error The product experienced an internal
communication error.

Turn off the product and disconnect the
power cable from the product. Wait
30 seconds and then reconnect the power
cord and turn on the product. Wait for the
product to initialize.

If you are using a surge protector, remove it.
Plug the product directly into the wall
socket. Use the power switch to turn on the
product.

If the message persists, contact HP support.

Front Access Door Open The door is open. Close the door.

Fuser Error The product has experienced an error with
the fuser.

Turn off the product and disconnect the
power cable from the product. Wait
30 seconds and then reconnect the power
cord and turn on the product. Wait for the
product to initialize.

If the error continues, turn off the product,
disconnect the power cable, wait at least
25 minutes, and then reconnect the power
cable and turn on the product.

If you are using a surge protector, remove it.
Plug the product directly into the wall
socket. Use the power switch to turn on the
product.

If the message persists, contact HP support.
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Alert message Description Recommended action

Imaging Drum Very Low The imaging drum is at the end of its useful
life.

To ensure optimal print quality, HP
recommends replacing the imaging drum at
this point. You do not need to replace the
imaging drum at this time unless print
quality is no longer acceptable. Actual
imaging drum life may vary.

The imaging drum installed in this product is
covered by the product warranty.
Replacement imaging drums have a one-
year limited warranty from the date of
installation. HP's Premium Protection
Warranty applies only to the print cartridge
for this product. The imaging drum
installation date displays on both the
configuration page and on the supplies
status page when the imaging drum
reaches approximately 30% of its estimated
remaining life.

Install <Color> Cartridge The cartridge is either not installed or not
correctly installed in the product.

Install the print cartridge.

Jam in <location>

(<location> indicates the area where the
jam has occurred)

The product has detected a jam. Clear the jam from the area indicated in the
message. The job should continue to print.
If it does not, try reprinting the job.

If the message persists, contact HP support.

Load Paper <Type> The tray is empty. Load print media into the tray.

Magenta Cartridge Low The print cartridge is nearing the estimated
end of its useful life.

The product indicates when a print cartridge
level is low. Actual cartridge life remaining
may vary. Consider having a replacement
available to install when print quality is no
longer acceptable. The print cartridge does
not need to be replaced now.

This alert displays only if the product is
customer configured to stop when the print
cartridge reaches the “very low” threshold.

Magenta Cartridge Very Low The print cartridge is at the estimated end of
its useful life.

Print quality may decrease. Choose a
reminder option or replace print cartridge
when quality becomes unacceptable.

To ensure optimal print quality, HP
recommends replacing the print cartridge at
this point. You do not need to replace the
print cartridge at this time unless print
quality is no longer acceptable. Actual print
cartridge life may vary.

Once an HP print cartridge has reached
“very low”, HP's Premium Protection
Warranty on that print cartridge has ended.
All print defects or cartridge failures incurred
when an HP supply is used in continue at
very low mode will not be considered to be
defects in materials or workmanship in the
supply under the HP Print Cartridge
Warranty Statement.

Manual feed The product is set for manual feed mode. Load the correct media into the tray, and
then press the Resume  button to print
the job.
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Alert message Description Recommended action

Non-HP <Color> Cartridge A non-HP supply has been installed. This
message appears until an HP supply is
installed or you press the Resume 
button.

If you believe you purchased an HP supply,
go to www.hp.com/go/anticounterfeit. Any
product repair required as a result of using
used supplies is not covered under
warranty. Supply status and features
depending on supply status will not be
available

Service or repairs that are required as a
result of using non-HP supplies are not
covered under HP warranty.

To continue printing, press the Resume 
button.

Not Connected The product software cannot communicate
with the product.

1. Make sure the product is turned on.

2. Make sure the USB cable is connected
securely to the product and the
computer.

Page Too Complex The product cannot process the page. Press the Resume  button to continue
printing the job, but output might be
affected.

Printer Mispick The print engine has failed to pick up a
piece of media.

Reload the media in the input tray and press
the Resume  button to continue the job.

If the message persists, contact HP support.

Printing The product is printing a document. Wait for printing to finish.

Rear Access Door Open The door is open. Close the door.

Replace <Color> cartridge The product has been customer configured
to stop when the supply level is very low.

The product indicates when a supply level is
very low. Actual cartridge life remaining may
vary. Consider having a replacement
available to install when print quality is no
longer acceptable. The supply does not
need to be replaced now unless the print
quality is no longer acceptable. Once an HP
supply has reached “Very Low”, HP’s
warranty on that supply has ended.

Scanner Error An internal error has occurred. Turn off the product and disconnect the
power cable from the product. Wait
30 seconds and then reconnect the power
cord and turn on the product. Wait for the
product to initialize.

If you are using a surge protector, remove it.
Plug the product directly into the wall
socket. Use the power switch to turn on the
product.

If the message persists, contact HP support.
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Alert message Description Recommended action

Supplies Very Low More than one print cartridge is at the end
of its useful life.

The corresponding cartridge lights on the
control panel remain on.

The product indicates when a supply level is
very low. Actual cartridge life remaining may
vary. Consider having a replacement
available to install when print quality is no
longer acceptable. The supply does not
need to be replaced now unless the print
quality is no longer acceptable. Once an HP
supply has reached “Very Low”, HP’s
warranty on that supply has ended.

Tray 1 Jam The product has detected a jam in the tray. Clear the jam.

Unexpected Paper Size The paper in the tray is not the size
specified by the print job.

Load the correct paper size in the input tray
and then press the Resume  button to
print the job.

Used <Color> cartridge A used supply has been installed. This
message appears until an HP supply is
installed or you press the Resume 
button.

If you believe you purchased an HP supply,
go to www.hp.com/go/anticounterfeit. Any
product repair required as a result of using
used supplies is not covered under
warranty. Supply status and features
depending on supply status will not be
available

Service or repairs that are required as a
result of using non-HP supplies are not
covered under HP warranty.

To continue printing, press the Resume 
button.

Wrong Cartridge in <Color> Slot A print cartridge is installed in the incorrect
slot.

Be sure that each print cartridge is in the
correct slot. Compare the color label on the
print cartridge with the color label in the slot.

Yellow Cartridge Low The print cartridge is nearing the estimated
end of its useful life.

The product indicates when a print cartridge
level is low. Actual cartridge life remaining
may vary. Consider having a replacement
available to install when print quality is no
longer acceptable. The print cartridge does
not need to be replaced now.

This alert displays only if the product is
customer configured to stop when the print
cartridge reaches the “very low” threshold.

Yellow Cartridge Very Low The print cartridge is at the estimated end of
its useful life.

Print quality may decrease. Choose a
reminder option or replace print cartridge
when quality becomes unacceptable.

To ensure optimal print quality, HP
recommends replacing the print cartridge at
this point. You do not need to replace the
print cartridge at this time unless print
quality is no longer acceptable. Actual print
cartridge life may vary.

Once an HP print cartridge has reached
“very low”, HP's Premium Protection
Warranty on that print cartridge has ended.
All print defects or cartridge failures incurred
when an HP supply is used in continue at
very low mode will not be considered to be
defects in materials or workmanship in the
supply under the HP Print Cartridge
Warranty Statement.
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Paper feeds incorrectly or becomes jammed

The product does not pick up paper

If the product does not pick up paper from the tray, try these solutions.

1. Open the product and remove any jammed sheets of paper.

2. Load the tray with the correct size of paper for your job.

NOTE: Always load paper so the short edge (width) enters the product first.

3. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the
guides so they are touching the paper stack without bending it.

4. Check the product control panel to see if the product is waiting for you to acknowledge a prompt
to feed the paper manually. Load paper, and continue.

The product picks up multiple sheets of paper

If the product picks up multiple sheets of paper from the tray, try these solutions.

1. Remove the stack of paper from the tray and flex it, rotate it 180 degrees, and flip it over. Do not
fan the paper. Return the stack of paper to the tray.

2. Use only paper that meets HP specifications for this product.

3. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different
package.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray,
straighten the stack, and then return some of the paper to the tray.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the
guides so they are touching the paper stack without bending it.

Prevent paper jams

To reduce the number of paper jams, try these solutions.

1. Use only paper that meets HP specifications for this product.

2. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different
package.

3. Use paper that has not previously been printed or copied on.

4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray,
straighten the stack, and then return some of the paper to the tray.

5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the
guides so they are touching the paper stack without bending it.

NOTE: Always load paper so the short edge (width) enters the product first.

6. If you are printing on heavy, embossed, or perforated paper, use the manual feed feature and
feed sheets one at a time.
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Clear jams
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Jam locations

Jams can occur in these locations:

1

3

2

1 Output bin

2 Rear door

3 Input tray

Loose toner might remain in the product after a jam. This problem typically resolves itself after a few
sheets have been printed.

Clear jams from the output bin

CAUTION: Do not use sharp objects, such as tweezers or needle-nose pliers, to remove jams.
Damage caused by sharp objects will not be covered by the warranty.
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1. With both hands, grasp the paper, and
carefully pull it free from the product.

 

2. Open and close the print cartridge door to
reset the product.

 

Clear jams from the rear door

1. Open the rear door.  
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2. With both hands, grasp the paper, and
carefully pull it free from the product.

 

3. Close the rear door.  

Clear jams from the input tray

1. Remove the paper from the input tray.  
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2. With both hands, grasp the paper, and
carefully pull it free from the product.

 

3. Open and close the print cartridge door to
reset the product.
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Improve print quality
You can prevent most print-quality problems by following these guidelines.

● Use the correct paper type setting in the printer driver

● Adjust color settings in the printer driver

● Use paper that meets HP specifications

● Print a cleaning page

● Calibrate the product to align colors

● Check the print cartridges

Use the correct paper type setting in the printer driver

Check the paper type setting if you are having any of the following problems:

● Toner is smearing on the printed pages.

● Repeated marks occur on the printed pages.

● Printed pages are curled.

● Toner flakes off the printed pages.

● Printed pages have small unprinted areas.

Change the paper type setting for Windows

1. On the File menu in the software program, click Print.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Paper/Quality tab.

4. From the Type is drop-down list, select the type of paper you are using, and click the OK button.

Change the paper type setting for Mac

1. On the File menu in the software program, click the Print option.

2. In the Copies & Pages menu, click the Page Setup button.

3. Select a size from the Paper Size drop-down list, and then click the OK button.

4. Open the Finishing menu.

5. Select a type from the Media-type drop-down list.

6. Click the Print button.
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Adjust color settings in the printer driver

Change the color theme for a print job

1. On the File menu in the software program, click Print.

2. Click Properties or Preferences.

3. Click the Color tab.

4. Select a color theme from the Color Themes drop-down list.

● Default (sRGB): This theme sets the product to print RGB data in raw device mode. When
using this theme, manage color in the software program or in the operating system for
correct rendering.

● Vivid: The product increases the color saturation in the midtones. Use this theme when
printing business graphics.

● Photo: The product interprets RGB color as if it were printed as a photograph using a
digital mini lab. The product renders deeper, more saturated colors differently than with the
Default (sRBG) theme. Use this theme when printing photos.

● Photo (Adobe RGB 1998): Use this theme with printing digital photos that use the
AdobeRGB color space rather than sRGB. Turn off color management in the software
program when using this theme.

● None

Change the color options

Change the color options settings for the current print job from the color tab of the printer driver.

1. On the File menu in the software program, click Print.

2. Click Properties or Preferences.

3. Click the Color tab.

112 Chapter 9   Solve problems ENWW



4. Click the Automatic or Manual setting.

● Automatic setting: Select this setting for most color print jobs

● Manual setting: Select this setting to adjust the color settings independent from other
settings.

NOTE: Changing color settings manually can impact output. HP recommends that only
color graphics experts change these settings.

5. Click the Print in Grayscale option to print a color document in black and white. Use this option
to print color documents for photocopying or faxing.

6. Click the OK button.

Use paper that meets HP specifications

Use different paper if you are having any of the following problems:

● The printing is too light or seems faded in areas.

● Specks of toner are on the printed pages.

● Toner is smearing on the printed pages.

● Printed characters seem misformed.

● Printed pages are curled.

Always use a paper type and weight that this product supports. In addition, follow these guidelines
when selecting paper:

● Use paper that is of good quality and free of cuts, nicks, tears, spots, loose particles, dust,
wrinkles, voids, staples, and curled or bent edges.

● Use paper that has not been previously printed on.

● Use paper that is designed for use in laser printers. Do not use paper that is designed only for
use in Inkjet printers.

● Use paper that is not too rough. Using smoother paper generally results in better print quality.
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Print a cleaning page

Print a cleaning page to remove dust and excess toner from the paper path if you are having any of
the following problems:

● Specks of toner are on the printed pages.

● Toner is smearing on the printed pages.

● Repeated marks occur on the printed pages.

Use the following procedure to print a cleaning page.

1. Make sure that the product is idle and the Ready  light is on.

2. Load paper in the input tray.

3. In the Windows system tray, right-click the Device Settings  icon and then click the product
name.

4. Click the Device Settings button.

5. Click the Print Cleaning Page button.

NOTE: The cleaning process takes about 2 minutes. The cleaning page stops periodically during
the cleaning process. Do not turn the product off until the cleaning process has finished. You might
need to repeat the cleaning process several times to thoroughly clean the product.

Calibrate the product to align colors

If you experience any print-quality problems, calibrate the product.

1. Make sure that the product is idle and the Ready  light is on.

2. Load paper in the input tray.

3. In the Windows system tray, right-click the Device Settings  icon and then click the product
name.

4. Click the Device Settings button.

5. Click the Calibrate Now button.

Check the print cartridges

Check each print cartridge, and replace it if necessary, if you are having any of the following
problems:

● The printing is too light or seems faded in areas.

● Printed pages have small unprinted areas.

● Printed pages have streaks or bands.

If you determine that you need to replace a print cartridge, print the Supplies Status Page to find the
part number for the correct genuine HP print cartridge.
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Type of print cartridge Steps to resolve the problem

Refilled or remanufactured print
cartridge

Hewlett Packard Company cannot recommend the use of non-HP supplies, either
new or remanufactured. Because they are not HP products, HP cannot influence
their design or control their quality. If you are using a refilled or remanufactured
print cartridge and are not satisfied with the print quality, replace the cartridge with
a genuine HP cartridge that has the words “HP” or “Hewlett-Packard” on it, or has
the HP logo on it.

Genuine HP print cartridge 1. The status alert message <Color> cartridge Very Low (or Replace Color
Cartridge, if the printer has been customer configured to stop at Very Low)
appears on the computer screen when the cartridge has reached the end of
its designated life. The product indicates when a supply level is very low.
Actual cartridge life remaining may vary. Consider having a replacement
available to install when print quality is no longer acceptable. The supply
does not need to be replaced now unless the print quality is no longer
acceptable. Once an HP supply has reached “Very Low”, HP’s warranty on
that supply has ended.

2. Visually inspect the print cartridges and imaging drum for debris and
damage. See the instructions that follow. Replace the print cartridge or
imaging drum if necessary.

3. If printed pages have marks that repeat several times at the same distance
apart, print a cleaning page. If this does not solve the problem, use the
repetitive defects ruler in this document to identify the cause of the problem.
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Print the Supplies Status page

Use the control panel to print configuration and supplies status pages that give details about the
product and its current settings.

▲ Print a supplies status page. Select Print supplies status page on the Services tab in the
Printer Preferences.

Page Description

Configuration page Prints a list of the product settings

Supplies Status page The supplies status page includes the following information:

● Approximate percentage of print cartridge life remaining

● Warranty for print cartridges and imaging drum

● Part numbers for HP print cartridges

● Number of pages printed

● Information about ordering new HP print cartridges and
recycling used HP print cartridges

● The imaging drum's estimated life remaining and
installation date display if less than 30% of its estimated
life remains.
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Interpret the Print Quality Page

1. Make sure that the product is idle and the Ready  light is on.

2. Load paper in the input tray.

3. In the Windows system tray, right-click the Device Settings  icon and then click the product
name.

4. Click the Device Settings button.

5. Click the Print PQ Troubleshooting Page button.

This page contains five bands of color, which are divided into four groups as indicated in the following
illustration. By examining each group, you can isolate the problem to a particular print cartridge.

Section Print-cartridge

1 Yellow

2 Cyan

3 Black

4 Magenta

● If dots or streaks appear in only one of the groups, replace the print cartridge that correlates with
that group.

● If dots appear in more than one group, print a cleaning page. If this does not solve the problem,
determine if the dots are always the same color; for example, if magenta dots appear in all five
color bands. If the dots are all the same color, replace that print cartridge.

● If streaks appear in multiple color bands, print a supplies status page to determine if the imaging
drum has reached its estimated end of life. If imaging drum has not reached its estimated end of
life, inspect the imaging drum for damage. If the imaging drum is not damaged, contact HP.

Inspect the print cartridge and imaging drum for damage

1. Remove the print cartridge from the product, and examine for damage.

2. If the print cartridge does not appear to be damaged, rock the print cartridge gently several times
and reinstall it. Print a few pages to see if the problem is resolved.
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3. If the problem is not resolved, remove the imaging drum from the product, and examine the
surface.

CAUTION: Do not touch the green roller. Fingerprints on the imaging drum can cause print-
quality problems.

4. If you see any scratches, fingerprints, or other damage on the imaging drum, replace the
imaging drum.

Repeating defects

If defects repeat at any of the following intervals on the page, a print cartridge or the imaging drum
might be damaged.

● 22 mm (print cartridge)

● 26 mm (imaging drum)

● 29 mm (print cartridge)

● 94 mm (imaging drum)
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The product does not print or it prints slowly

The product does not print

If the product does not print at all, try the following solutions.

1. Make sure the product is turned on and that the control panel indicates it is ready.

◦ If the control panel does not indicate the product is ready, turn off the product and
disconnect the power cable from the product. Wait 30 seconds and then reconnect the
power cord and turn on the product. Wait for the product to initialize.

◦ If the control panel indicates the product is ready, press and hold the Resume  button for
two to three seconds to print a configuration page. If successful, try sending the job again.

2. If the control panel indicates the product has an error, resolve the error and then try sending the
job again.

3. Make sure the cables are all connected correctly. If the product is connected to a network, check
the following items:

◦ Check the light next to the network connection on the product. If the network is active, the
light is green.

◦ Make sure that you are using a network cable and not a phone cord to connect to the
network.

◦ Make sure the network router, hub, or switch is turned on and that it is working correctly.

4. Install the HP software from the CD that came with the product. Using generic printer drivers can
cause delays clearing jobs from the print queue.

5. If you are using a personal firewall system on the computer, it might be blocking communication
with the product. Try temporarily disabling the firewall to see if it is the source of the problem.

6. If your computer or the product is connected to a wireless network, low signal quality or
interference might be delaying print jobs.

The product prints slowly

If the product prints, but it seems slow, try the following solutions.

1. Make sure the computer meets the minimum specifications for this product. For a list of
specifications, go to this Web site: www.hp.com/support/ljcp1020series.

2. When you configure the product to print on some paper types, such as heavy paper, the product
prints more slowly so it can correctly fuse the toner to the paper. If the paper type setting is not
correct for the type of paper you are using, change the setting to the correct paper type.

3. If your computer or the product is connected to a wireless network, low signal quality or
interference might be delaying print jobs.

4. The product might be in cool down mode.
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Solve connectivity problems 

Solve direct-connect problems

If you have connected the product directly to a computer, check the cable.

● Verify that the cable is connected to the computer and to the product.

● Verify that the cable is not longer than 5 m (16.4 ft). Try using a shorter cable.

● Verify that the cable is working correctly by connecting it to another product. Replace the cable if
necessary.

Solve network problems

Check the following items to verify that the product is communicating with the network. Before
beginning, print a configuration page from the product control panel and locate the product IP
address that is listed on this page.

● Poor physical connection

● The computer is using the incorrect IP address for the product

● The computer is unable to communicate with the product

● The product is using incorrect link and duplex settings for the network

● New software programs might be causing compatibility problems

● The computer or workstation might be set up incorrectly

● The product is disabled, or other network settings are incorrect

Poor physical connection

1. Verify that the product is attached to the correct network port using a cable of the correct length.

2. Verify that cable connections are secure.

3. Look at the network port connection on the back of the product, and verify that the amber activity
light and the green link-status light are lit.

4. If the problem continues, try a different cable or port on the hub.

The computer is using the incorrect IP address for the product

1. Open the printer properties and click the Ports tab. Verify that the current IP address for the
product is selected. The product IP address is listed on the product configuration page.

2. If you installed the product using the HP standard TCP/IP port, select the box labeled Always
print to this printer, even if its IP address changes.

3. If you installed the product using a Microsoft standard TCP/IP port, use the hostname instead of
the IP address.

4. If the IP address is correct, delete the product and then add it again.
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The computer is unable to communicate with the product

1. Test network communication by pinging the network.

a. Open a command-line prompt on your computer. For Windows, click Start, click Run, and
then type cmd.

b. Type ping followed by the IP address for your product.

c. If the window displays round-trip times, the network is working.

2. If the ping command failed, verify that the network hubs are on, and then verify that the network
settings, the product, and the computer are all configured for the same network.

The product is using incorrect link and duplex settings for the network

Hewlett-Packard recommends leaving this setting in automatic mode (the default setting). If you
change these settings, you must also change them for your network.

New software programs might be causing compatibility problems

Verify that any new software programs are correctly installed and that they use the correct printer
driver.

The computer or workstation might be set up incorrectly

1. Check the network drivers, printer drivers, and the network redirection.

2. Verify that the operating system is configured correctly.

The product is disabled, or other network settings are incorrect

1. Review the configuration page to check the status of the network protocol. Enable it if
necessary.

2. Reconfigure the network settings if necessary.
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Solve wireless network problems

Wireless connectivity checklist

● Make sure the network cable is not connected.

● The product and the wireless router are turned on and have power. Also make sure the wireless
radio in the product is turned on.

● The service set identifier (SSID) is correct. Print a configuration page to determine the SSID. If
you are not sure the SSID is correct, run the wireless setup again.

● With secured networks, make sure the security information is correct. If the security information
is incorrect, run the wireless setup again.

● If the wireless network is working correctly, try accessing other computers on the wireless
network. If the network has Internet access, try connecting to the Internet over a wireless
connection.

● The encryption method (AES or TKIP) is the same for the product as it is for the wireless access
point (on networks using WPA security).

● The product is within the range of the wireless network. For most networks, the product must be
within 30 m (100 ft) of the wireless access point (wireless router).

● Obstacles do not block the wireless signal. Remove any large metal objects between the access
point and the product. Make sure poles, walls, or support columns containing metal or concrete
do not separate the product and wireless access point.

● The product is located away from electronic devices that might interfere with the wireless signal.
Many devices can interfere with the wireless signal including motors, cordless phones, security
system cameras, other wireless networks, and some Bluetooth devices.

● The printer driver is installed on the computer.

● You have selected the correct printer port.

● The computer and product connect to the same wireless network.

The product does not print after the wireless configuration completes

1. Make sure the product is turned on and in the ready state.

2. Turn off any third-party firewalls on your computer.

3. Make sure that the wireless network is working correctly.

4. Make sure that your computer is working correctly. If necessary, restart your computer.
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The product does not print, and the computer has a third-party firewall
installed

1. Update the firewall with the most recent update available from the manufacturer.

2. If programs request firewall access when you install the product or try to print, make sure you
allow the programs to run.

3. Temporarily turn off the firewall, and then install the wireless product on the computer. Enable
the firewall when you have completed the wireless installation.

The wireless connection does not work after moving the wireless router or
product

Make sure that the router or product connects to the same network that your computer connects to.

1. Print a configuration page.

2. Compare the service set identifier (SSID) on the configuration page to the SSID in the printer
configuration for your computer.

3. If the numbers are not the same, the devices are not connecting to the same network.
Reconfigure the wireless setup for your product.

Cannot connect more computers to the wireless product

1. Make sure that the other computers are within the wireless range and that no obstacles block
the signal. For most networks, the wireless range is within 30 m (100 ft) of the wireless access
point.

2. Make sure the product is turned on and in the ready state.

3. Turn off any third-party firewalls on your computer.

4. Make sure that the wireless network is working correctly.

5. Make sure that your computer is working correctly. If necessary, restart your computer.

The wireless product loses communication when connected to a VPN

● Typically, you cannot connect to a VPN and other networks at the same time.

The network does not appear in the wireless networks list

● Make sure the wireless router is turned on and has power.

● The network might be hidden. However, you can still connect to a hidden network.

The wireless network is not functioning

1. Make sure the network cable is not connected.

2. To verify if the network has lost communication, try connecting other devices to the network.
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3. Test network communication by pinging the network.

a. Open a command-line prompt on your computer. For Windows, click Start, click Run, and
then type cmd.

b. Type ping followed by the service set identifier (SSID) for your network.

c. If the window displays round-trip times, the network is working.

4. Make sure that the router or product connects to the same network that your computer connects
to.

a. Print a configuration page.

b. Compare the service set identifier (SSID) on the configuration report to the SSID in the
printer configuration for your computer.

c. If the numbers are not the same, the devices are not connecting to the same network.
Reconfigure the wireless setup for your product.
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Solve product software problems

Problem Solution

A printer driver for the product is not visible in the Printer
folder

● Restart the computer to restart the spooler process. If
the spooler has crashed, no printer drivers will appear in
the Printers folder.

● Reinstall the product software.

NOTE: Close any applications that are running. To
close an application that has an icon in the system tray,
right-click the icon, and select Close or Disable.

● Try plugging the USB cable into a different USB port on
the computer.

An error message was displayed during the software
installation

● Reinstall the product software.

NOTE: Close any applications that are running. To
close an application that has an icon in the task bar,
right-click the icon, and select Close or Disable.

● Check the amount of free space on the drive where you
are installing the product software. If necessary, free up
as much space as you can, and reinstall the product
software.

● If necessary, run the Disk Defragmenter, and reinstall
the product software.

The product is in Ready mode, but nothing prints ● Print a Configuration page, and verify the product
functionality.

● Verify that all of the cables are correctly seated and
within specifications. This includes the USB and power
cables. Try a new cable.

● If trying to connect through a wireless connection, make
sure the network cable is not connected.
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Solve common Mac problems
● The printer driver is not listed in the Print & Fax list

● The product name does not appear in the product list in the Print & Fax list

● The printer driver does not automatically set up the selected product in the Print & Fax list

● A print job was not sent to the product that you wanted

● When connected with a USB cable, the product does not appear in the Print & Fax list after the
driver is selected.

● You are using a generic printer driver when using a USB connection

The printer driver is not listed in the Print & Fax list

1. Make sure that the product .GZ file is in the following hard-drive folder: Library/Printers/
PPDs/Contents/Resources. If necessary, reinstall the software.

2. If the GZ file is in the folder, the PPD file might be corrupt. Delete the file and then reinstall the
software.

The product name does not appear in the product list in the Print & Fax
list

1. Make sure that the cables are connected correctly and the product is on.

2. Print a configuration page to check the product name. Verify that the name on the configuration
page matches the product name in the Print & Fax list.

3. Replace the USB or network cable with a high-quality cable.

The printer driver does not automatically set up the selected product in
the Print & Fax list

1. Make sure that the cables are connected correctly and the product is on.

2. Make sure that the product .GZ file is in the following hard-drive folder: Library/Printers/
PPDs/Contents/Resources. If necessary, reinstall the software.

3. If the GZ file is in the folder, the PPD file might be corrupt. Delete the file and then reinstall the
software.

4. Replace the USB or network cable with a high-quality cable.

A print job was not sent to the product that you wanted

1. Open the print queue and restart the print job.

2. Another product with the same or similar name might have received your print job. Print a
configuration page to check the product name. Verify that the name on the configuration page
matches the product name in the Print & Fax list.
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When connected with a USB cable, the product does not appear in the
Print & Fax list after the driver is selected.

Software troubleshooting

▲ Make sure that your Mac operating system is Mac OS X 10.5 or later.

Hardware troubleshooting

1. Make sure that the product is turned on.

2. Make sure that the USB cable is connected correctly.

3. Make sure that you are using the appropriate high-speed USB cable.

4. Make sure that you do not have too many USB devices drawing power from the chain.
Disconnect all of the devices from the chain, and connect the cable directly to the USB port on
the computer

5. Check to see if more than two non-powered USB hubs are connected in a row on the chain.
Disconnect all of the devices from the chain, and then connect the cable directly to the USB port
on the computer.

NOTE: The iMac keyboard is a non-powered USB hub.

You are using a generic printer driver when using a USB connection

If you connected the USB cable before you installed the software, you might be using a generic
printer driver instead of the driver for this product.

1. Delete the generic printer driver.

2. Reinstall the software from the product CD. Do not connect the USB cable until the software
installation program prompts you.

3. If multiple printers are installed, make sure that you have selected the correct printer in the
Format For drop-down menu in the Print dialog box.
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A Supplies and accessories

● Order parts, accessories, and supplies

● Part numbers
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Order parts, accessories, and supplies

HP original print cartridge, imaging drum, and paper www.hp.com/go/suresupply

Order genuine HP parts or accessories www.hp.com/buy/parts

Order through service or support providers Contact an HP-authorized service or support provider.

Part numbers
The following list of accessories was current at the time of printing. Ordering information and
availability of the accessories might change during the life of the product.

Print cartridges

Item Cartridge number Color Part number

HP LaserJet print cartridge 126A Black CE310A

Cyan CE311A

Yellow CE312A

Magenta CE313A

Imaging drums

Item Description Part number

Imaging drum Imaging drum CE314A

NOTE: The imaging drum installed in this product is covered by the product warranty. Replacement
imaging drums have a one-year limited warranty from the date of installation. The imaging drum
installation date displays on both the configuration page and on the supplies status page when the
imaging drum reaches approximately 30% of its estimated remaining life. HP's Premium Protection
Warranty applies only to the print cartridges for the product.

Cables and interfaces

Item Description Part number

USB 2.0 printer cable (2-meter standard) A-to-B cable C6518A
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B Service and support

● Hewlett-Packard limited warranty statement

● HP's Premium Protection Warranty: LaserJet print cartridge limited warranty statement

● HP's LaserJet imaging drum limited warranty statement for replacement imaging drums

● Data stored on the print cartridge and imaging drum

● End User License Agreement

● OpenSSL

● Customer support

● Repack the product
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Hewlett-Packard limited warranty statement

HP PRODUCT DURATION OF LIMITED WARRANTY

HP LaserJet Professional CP1025, CP1025nw One-year product exchange

Imaging drum, CE314A, ships with product One-year product exchange

HP warrants to you, the end-user customer, that HP hardware and accessories will be free from
defects in materials and workmanship after the date of purchase, for the period specified above. If HP
receives notice of such defects during the warranty period, HP will, at its option, either repair or
replace products which prove to be defective. Replacement products may be either new or equivalent
in performance to new.

HP warrants to you that HP software will not fail to execute its programming instructions after the date
of purchase, for the period specified above, due to defects in material and workmanship when
properly installed and used. If HP receives notice of such defects during the warranty period, HP will
replace software which does not execute its programming instructions due to such defects.

HP does not warrant that the operation of HP products will be uninterrupted or error free. If HP is
unable, within a reasonable time, to repair or replace any product to a condition as warranted, you will
be entitled to a refund of the purchase price upon prompt return of the product.

HP products may contain remanufactured parts equivalent to new in performance or may have been
subject to incidental use.

Warranty does not apply to defects resulting from (a) improper or inadequate maintenance or
calibration, (b) software, interfacing, parts or supplies not supplied by HP, (c) unauthorized
modification or misuse, (d) operation outside of the published environmental specifications for the
product, or (e) improper site preparation or maintenance.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTIES ARE EXCLUSIVE AND
NO OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR
IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.
Some countries/regions, states or provinces do not allow limitations on the duration of an implied
warranty, so the above limitation or exclusion might not apply to you. This warranty gives you specific
legal rights and you might also have other rights that vary from country/region to country/region, state
to state, or province to province.

HP's limited warranty is valid in any country/region or locality where HP has a support presence for
this product and where HP has marketed this product. The level of warranty service you receive may
vary according to local standards. HP will not alter form, fit or function of the product to make it
operate in a country/region for which it was never intended to function for legal or regulatory reasons.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES IN THIS WARRANTY STATEMENT
ARE YOUR SOLE AND EXCLUSIVE REMEDIES. EXCEPT AS INDICATED ABOVE, IN NO EVENT
WILL HP OR ITS SUPPLIERS BE LIABLE FOR LOSS OF DATA OR FOR DIRECT, SPECIAL,
INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR OTHER DAMAGE,
WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE. Some countries/regions, states or
provinces do not allow the exclusion or limitation of incidental or consequential damages, so the
above limitation or exclusion may not apply to you.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT
LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION
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TO THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT
TO YOU.
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HP's Premium Protection Warranty: LaserJet print
cartridge limited warranty statement

This HP product is warranted to be free from defects in materials and workmanship.

This warranty does not apply to products that (a) have been refilled, refurbished, remanufactured or
tampered with in any way, (b) experience problems resulting from misuse, improper storage, or
operation outside of the published environmental specifications for the printer product or (c) exhibit
wear from ordinary use.

To obtain warranty service, please return the product to place of purchase (with a written description
of the problem and print samples) or contact HP customer support. At HP's option, HP will either
replace products that prove to be defective or refund your purchase price.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTY IS EXCLUSIVE AND NO
OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR
IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.

TO THE EXTENT ALLOWED BY LOCAL LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE
LIABLE FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR
DATA), OR OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT
LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION
TO THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT
TO YOU.
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HP's LaserJet imaging drum limited warranty statement
for replacement imaging drums

This HP Product is warranted to be free from defects in materials and workmanship for one-year from
installation. This warranty does not apply to imaging drums that (a) have been refurbished,
remanufactured or tampered with in any way, (b) experience problems resulting from misuse,
improper storage, or operation outside of the published environmental specifications for the printer
product or (c) exhibit wear from ordinary use.

To obtain warranty service, please return the product to place of purchase (with a written description
of the problem, print samples, and a copy of the configuration and supplies status page) or contact
HP customer support. At HP’s option, HP will either replace products that prove to be defective or
refund your purchase price.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTY IS EXCLUSIVE AND NO
OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR
IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.

TO THE EXTENT ALLOWED BY LOCAL LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE
LIABLE FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR
DATA), OR OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT
LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION
TO THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT
TO YOU.
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Data stored on the print cartridge and imaging drum
The HP print cartridges and imaging drum used with this product contain a memory chip that assists
in the operation of the product.

In addition, this memory chip collects a limited set of information about the usage of the product,
which might include the following: the date when the print cartridge and imaging drum was first
installed, the date when the print cartridge and imaging drum was last used, the number of pages
printed using the print cartridge and imaging drum, the page coverage, the printing modes used, any
printing errors that might have occurred, and the product model. This information helps HP design
future products to meet our customers' printing needs.

The data collected from the print cartridge and imaging drum memory chip does not contain
information that can be used to identify a customer or user of the print cartridge and imaging drum or
their product.

HP collects a sampling of the memory chips from print cartridges and imaging drums returned to HP's
free return and recycling program (HP Planet Partners: www.hp.com/recycle). The memory chips
from this sampling are read and studied in order to improve future HP products. HP partners who
assist in recycling this print cartridge and imaging drum might have access to this data, as well.

Any third party possessing the print cartridge and imaging drum might have access to the anonymous
information on the memory chip. If you prefer to not allow access to this information, you can render
the chip inoperable. However, after you render the memory chip inoperable, the memory chip cannot
be used in an HP product.
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End User License Agreement
PLEASE READ CAREFULLY BEFORE USING THIS SOFTWARE PRODUCT: This End-User
License Agreement (“EULA”) is a contract between (a) you (either an individual or the entity you
represent) and (b) Hewlett-Packard Company (“HP”) that governs your use of the software product
(“Software”). This EULA does not apply if there is a separate license agreement between you and HP
or its suppliers for the Software, including a license agreement in online documentation. The term
“Software” may include (i) associated media, (ii) a user guide and other printed materials, and (iii)
“online” or electronic documentation (collectively “User Documentation”).

RIGHTS IN THE SOFTWARE ARE OFFERED ONLY ON THE CONDITION THAT YOU AGREE TO
ALL TERMS AND CONDITIONS OF THIS EULA. BY INSTALLING, COPYING, DOWNLOADING,
OR OTHERWISE USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THIS EULA. IF YOU
DO NOT ACCEPT THIS EULA, DO NOT INSTALL, DOWNLOAD, OR OTHERWISE USE THE
SOFTWARE. IF YOU PURCHASED THE SOFTWARE BUT DO NOT AGREE TO THIS EULA,
PLEASE RETURN THE SOFTWARE TO YOUR PLACE OF PURCHASE WITHIN FOURTEEN
DAYS FOR A REFUND OF THE PURCHASE PRICE; IF THE SOFTWARE IS INSTALLED ON OR
MADE AVAILABLE WITH ANOTHER HP PRODUCT, YOU MAY RETURN THE ENTIRE UNUSED
PRODUCT.

1. THIRD PARTY SOFTWARE. The Software may include, in addition to HP proprietary software
(“HP Software”), software under licenses from third parties (“Third Party Software” and “Third Party
License”). Any Third Party Software is licensed to you subject to the terms and conditions of the
corresponding Third Party License. Generally, the Third Party License is located in a file such as
license.txt; you should contact HP support if you cannot find any Third Party License. If the Third
Party Licenses include licenses that provide for the availability of source code (such as the GNU
General Public License) and the corresponding source code is not included with the Software, then
check the product support pages of HP’s website (hp.com) to learn how to obtain such source code.

2. LICENSE RIGHTS. You will have the following rights provided you comply with all terms and
conditions of this EULA:

a. Use. HP grants you a license to Use one copy of the HP Software. “Use” means installing, copying,
storing, loading, executing, displaying, or otherwise using the HP Software. You may not modify the
HP Software or disable any licensing or control feature of the HP Software. If this Software is
provided by HP for Use with an imaging or printing product (for example, if the Software is a printer
driver, firmware, or add-on), the HP Software may only be used with such product (“HP Product”).
Additional restrictions on Use may appear in the User Documentation. You may not separate
component parts of the HP Software for Use. You do not have the right to distribute the HP Software.

b. Copying. Your right to copy means you may make archival or back-up copies of the HP Software,
provided each copy contains all the original HP Software’s proprietary notices and is used only for
back-up purposes.

3. UPGRADES. To Use HP Software provided by HP as an upgrade, update, or supplement
(collectively “Upgrade”), you must first be licensed for the original HP Software identified by HP as
eligible for the Upgrade. To the extent the Upgrade supersedes the original HP Software, you may no
longer use such HP Software. This EULA applies to each Upgrade unless HP provides other terms
with the Upgrade. In case of a conflict between this EULA and such other terms, the other terms will
prevail.

4. TRANSFER.

a. Third Party Transfer. The initial end user of the HP Software may make a one-time transfer of the
HP Software to another end user. Any transfer will include all component parts, media, User
Documentation, this EULA, and if applicable, the Certificate of Authenticity. The transfer may not be
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an indirect transfer, such as a consignment. Prior to the transfer, the end user receiving the
transferred Software will agree to this EULA. Upon transfer of the HP Software, your license is
automatically terminated.

b. Restrictions. You may not rent, lease or lend the HP Software or Use the HP Software for
commercial timesharing or bureau use. You may not sublicense, assign or otherwise transfer the
HP Software except as expressly provided in this EULA.

5. PROPRIETARY RIGHTS. All intellectual property rights in the Software and User Documentation
are owned by HP or its suppliers and are protected by law, including applicable copyright, trade
secret, patent, and trademark laws. You will not remove any product identification, copyright notice, or
proprietary restriction from the Software.

6. LIMITATION ON REVERSE ENGINEERING. You may not reverse engineer, decompile, or
disassemble the HP Software, except and only to the extent that the right to do so is allowed under
applicable law.

7. CONSENT TO USE OF DATA. HP and its affiliates may collect and use technical information you
provide in relation to (i) your Use of the Software or the HP Product, or (ii) the provision of support
services related to the Software or the HP Product. All such information will be subject to HP’s privacy
policy. HP will not use such information in a form that personally identifies you except to the extent
necessary to enhance your Use or provide support services.

8. LIMITATION OF LIABILITY. Notwithstanding any damages that you might incur, the entire liability
of HP and its suppliers under this EULA and your exclusive remedy under this EULA will be limited to
the greater of the amount actually paid by you for the Product or U.S. $5.00. TO THE MAXIMUM
EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE
LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES
(INCLUDING DAMAGES FOR LOST PROFITS, LOST DATA, BUSINESS INTERRUPTION,
PERSONAL INJURY, OR LOSS OF PRIVACY) RELATED IN ANY WAY TO THE USE OF OR
INABILITY TO USE THE SOFTWARE, EVEN IF HP OR ANY SUPPLIER HAS BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES AND EVEN IF THE ABOVE REMEDY FAILS OF ITS
ESSENTIAL PURPOSE. Some states or other jurisdictions do not allow the exclusion or limitation of
incidental or consequential damages, so the above limitation or exclusion may not apply to you.

9. U.S. GOVERNMENT CUSTOMERS. If you are a U.S. Government entity, then consistent with
FAR 12.211 and FAR 12.212, Commercial Computer Software, Computer Software Documentation,
and Technical Data for Commercial Items are licensed under the applicable HP commercial license
agreement.

10. COMPLIANCE WITH EXPORT LAWS. You will comply with all laws, rules, and regulations (i)
applicable to the export or import of the Software, or (ii) restricting the Use of the Software, including
any restrictions on nuclear, chemical, or biological weapons proliferation.

11. RESERVATION OF RIGHTS. HP and its suppliers reserve all rights not expressly granted to you
in this EULA.

(c) 2007 Hewlett-Packard Development Company, L.P.

Rev. 11/06
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OpenSSL
This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit
(http://www.openssl.org/)

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY EXPRESSED
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN
NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;

LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This
product includes software written by Tim Hudson (tjh@cryptsoft.com).

Customer support

Get telephone support for your country/region

Have the product name, serial number, date of purchase,
and problem description ready.

Country/region phone numbers are on the flyer that was in
the box with your product or at www.hp.com/support/.

Get 24-hour Internet support www.hp.com/support/ljcp1020series

Get support for products used with a Macintosh computer www.hp.com/go/macosx

Download software utilities, drivers, and electronic
information

www.hp.com/support/ljcp1020series

Order additional HP service or maintenance agreements www.hp.com/go/carepack

Register your product www.register.hp.com

ENWW OpenSSL 139

http://www.hp.com/support/
http://h20180.www2.hp.com/apps/CLC?h_pagetype=s-001&h_lang=en&h_product=4052954&h_client=s-h-e009-1&h_page=hpcom&lang=en
http://www.hp.com/go/macosx
http://h20180.www2.hp.com/apps/CLC?h_pagetype=s-001&h_lang=en&h_product=4052954&h_client=s-h-e009-1&h_page=hpcom&lang=en
http://www.hp.com/go/carepack
http://www.register.hp.com


Repack the product
If HP Customer Care determines that your product needs to be returned to HP for repair, follow these
steps to repack the product before shipping it.

CAUTION: Shipping damage as a result of inadequate packing is the customer’s responsibility.

1. Remove and retain the print cartridges.

CAUTION: It is extremely important to remove the print cartridges before shipping the product.
A print cartridge that remains in the product during shipping can leak and cover the product
engine and other parts with toner.

To prevent damage to the print cartridges, avoid touching the rollers on them, and store the print
cartridges so that they are not exposed to light.

2. Remove and retain the power cable, interface cable, and any optional accessories.

3. If possible, include print samples and 50 to 100 sheets of paper that did not print correctly.

4. In the U.S., call HP Customer Care to request new packing material. In other areas, use the
original packing material, if possible.
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C Specifications

● Physical specifications

● Power consumption, electrical specifications, and acoustic emissions

● Environmental specifications
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Physical specifications
Table C-1  Physical specifications1

Specification HP LaserJet Pro CP1020 Color Printer Series

Product weight 11.6 kg (25.6 lb)

Product height 222.8 mm (8.77 in)

Product depth 410.2 mm (16.15 in)

Product width 399.6 mm (15.73 in)

1 Values are based on preliminary data. See www.hp.com/support/ljcp1020series.

Power consumption, electrical specifications, and
acoustic emissions

See www.hp.com/support/ljcp1020series for current information.

CAUTION: Power requirements are based on the country/region where the product is sold. Do not
convert operating voltages. This will damage the product and void the product warranty.

Environmental specifications
Table C-2  Environmental specifications

 Operating1 Storage1

Temperature 10° to 32.5°C (50° to 91°F) 0° to 35°C (32° to 95°F)

Relative Humidity 10% to 80% 10% to 80%

1 Values are based on preliminary data. See www.hp.com/support/ljcp1020series.
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● Safety statements

● Additional statements for wireless products
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FCC regulations
This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses, and can
radiate radio frequency energy. If this equipment is not installed and used in accordance with the
instructions, it may cause harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by one or more of the
following measures:

● Reorient or relocate the receiving antenna.

● Increase separation between equipment and receiver.

● Connect equipment to an outlet on a circuit different from that to which the receiver is located.

● Consult your dealer or an experienced radio/TV technician.

NOTE: Any changes or modifications to the printer that are not expressly approved by HP could
void the user’s authority to operate this equipment.

Use of a shielded interface cable is required to comply with the Class B limits of Part 15 of FCC rules.
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Environmental product stewardship program

Protecting the environment

Hewlett-Packard Company is committed to providing quality products in an environmentally sound
manner. This product has been designed with several attributes to minimize impacts on our
environment.

Ozone production

This product generates no appreciable ozone gas (O3).

Power consumption

Power usage drops significantly while in Ready or Sleep mode, which saves natural resources and
saves money without affecting the high performance of this product. Hewlett-Packard printing and
imaging equipment marked with the ENERGY STAR® logo is qualified to the U.S. Environmental
Protection Agency's ENERGY STAR specifications for imaging equipment. The following mark will
appear on ENERGY STAR qualified imaging products:

Additional ENERGY STAR qualified imaging product model information is listed at:

www.hp.com/go/energystar

Paper use

This product’s manual duplex feature (two-sided printing) and N-up printing (multiple pages printed on
one page) capability can reduce paper usage and the resulting demands on natural resources.

Plastics

Plastic parts over 25 grams are marked according to international standards that enhance the ability
to identify plastics for recycling purposes at the end of the product’s life.

HP LaserJet print supplies

It’s easy to return and recycle your HP LaserJet print cartridges after use—free of charge—with
HP Planet Partners. Multilingual program information and instructions are included in every new
HP LaserJet print cartridge and supplies package. You help reduce the toll on the environment further
when you return multiple cartridges together rather than separately.

HP is committed to providing inventive, high-quality products and services that are environmentally
sound, from product design and manufacturing to distribution, customer use and recycling. When you
participate in the HP Planet Partners program, we ensure your HP LaserJet print cartridges are
recycled properly, processing them to recover plastics and metals for new products and diverting
millions of tons of waste from landfills. Since this cartridge is being recycled and used in new
materials, it will not be returned to you. Thank you for being environmentally responsible!
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NOTE: Use the return label to return original HP LaserJet print cartridges only. Please do not use
this label for HP inkjet cartridges, non-HP cartridges, refilled or remanufactured cartridges or warranty
returns. For information about recycling your HP inkjet cartridges please go to http://www.hp.com/
recycle.

Return and recycling instructions

United States and Puerto Rico

The enclosed label in the HP LaserJet toner cartridge box is for the return and recycling of one or
more HP LaserJet print cartridges after use. Please follow the applicable instructions below.

Multiple returns (more than one cartridge)

1. Package each HP LaserJet print cartridge in its original box and bag.

2. Tape the boxes together using strapping or packaging tape. The package can weigh up to 31 kg
(70 lb).

3. Use a single pre-paid shipping label.

OR

1. Use your own suitable box, or request a free bulk collection box from www.hp.com/recycle or
1-800-340-2445 (holds up to 31 kg (70 lb) of HP LaserJet print cartridges).

2. Use a single pre-paid shipping label.

Single returns

1. Package the HP LaserJet print cartridge in its original bag and box.

2. Place the shipping label on the front of the box.

Shipping

For all HP LaserJet print cartridge recycling returns, give the package to UPS during your next
delivery or pickup, or take it to an authorized UPS drop-off center. For the location of your local UPS
drop-off center, call 1-800-PICKUPS or visit www.ups.com. If you are returning via USPS label, give
the package to a U.S. Postal Service carrier or drop off at a U.S. Postal Service Office. For more
information, or to order additional labels or boxes for bulk returns, visit www.hp.com/recycle or call
1-800-340-2445. Requested UPS pickup will be charged normal pickup rates. Information subject to
change without notice.

Residents of Alaska and Hawaii

Do not use the UPS label. Call 1-800-340-2445 for information and instructions. The U.S. Postal
Service provides no-cost cartridge return transportation services under an arrangement with HP for
Alaska and Hawaii.

Non-U.S. returns

To participate in HP Planet Partners return and recycling program, just follow the simple directions in
the recycling guide (found inside the packaging of your new product supply item) or visit
www.hp.com/recycle. Select your country/region for information on how to return your HP LaserJet
printing supplies.

146 Appendix D   Regulatory information ENWW

http://www.hp.com/recycle
http://www.hp.com/recycle
http://www.hp.com/recycle
http://www.ups.com
http://www.hp.com/recycle
http://www.hp.com/recycle


Paper

This product is capable of using recycled papers when the paper meets the guidelines outlined in the
HP LaserJet Printer Family Print Media Guide. This product is suitable for the use of recycled paper
according to EN12281:2002.

Material restrictions

This HP product does not contain added mercury.

This HP product does not contain a battery.

Disposal of waste equipment by users in private households in the
European Union

This symbol on the product or on its packaging indicates that this product must not be disposed of
with your other household waste. Instead, it is your responsibility to dispose of your waste equipment
by handing it over to a designated collection point for the recycling of waste electrical and electronic
equipment. The separate collection and recycling of your waste equipment at the time of disposal will
help to conserve natural resources and ensure that it is recycled in a manner that protects human
health and the environment. For more information about where you can drop off your waste
equipment for recycling, please contact your local city office, your household waste disposal service
or the shop where you purchased the product.

Chemical substances

HP is committed to providing our customers with information about the chemical substances in our
products as needed to comply with legal requirements such as REACH (Regulation EC No
1907/2006 of the European Parliament and the Council). A chemical information report for this
product can be found at: www.hp.com/go/reach.

Material Safety Data Sheet (MSDS)

Material Safety Data Sheets (MSDS) for supplies containing chemical substances (for example,
toner) can be obtained by accessing the HP Web site at www.hp.com/go/msds or www.hp.com/
hpinfo/community/environment/productinfo/safety.

For more information

To obtain information about these environmental topics:

● Product environmental profile sheet for this and many related HP products

● HP’s commitment to the environment

● HP’s environmental management system

● HP’s end-of-life product return and recycling program

● Material Safety Data Sheets

Visit www.hp.com/go/environment or www.hp.com/hpinfo/globalcitizenship/environment.
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Declaration of conformity (base models)
Declaration of Conformity

according to ISO/IEC 17050-1 and EN 17050-1

Manufacturer's Name: Hewlett-Packard Company DoC#: BOISB-1001-00-rel.1.0

Manufacturer's Address: 11311 Chinden Boulevard

Boise, Idaho 83714-1021, USA

declares, that the product

Product Name: HP LaserJet Professional CP1025

Regulatory Model Number2) BOISB-1001-00

Product Options: ALL

Print Cartridges: CE310A, CE311A, CE312A, CE313A

conforms to the following Product Specifications:

SAFETY: IEC 60950-1:2005 / EN60950-1: 2006

IEC 60825-1:2006 / EN 60825-1:2007 Class 1 Laser/LED Product)

IEC 62311:2007 / EN 62311:2008

GB4943-2001

EMC: CISPR22:2005 +A1 / EN55022:2006 +A1 - Class B1)

EN 61000-3-2:2006

EN 61000-3-3:1995 +A1 +A2

EN 55024:1998 +A1 +A2

FCC Title 47 CFR, Part 15 Class B1) / ICES-003, Issue 4

GB9254-2008, GB17625.1-2003

ENERGY USE: Regulation (EC) No. 1275/2008

Supplementary Information:

The product herewith complies with the requirements of the EMC Directive 2004/108/EC and the Low Voltage Directive 2006/95/EC, the

EuP Directive 2005/32/EC, and carries the CE-Marking  accordingly.

This Device complies with Part 15 of the FCC Rules. Operation is subject to the following two Conditions: (1) this device may not cause
harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired
operation.

1. The product was tested in a typical configuration with Hewlett-Packard Personal Computer Systems.

2. For regulatory purposes, this product is assigned a Regulatory model number. This number should not be confused with the product
name or the product number(s).

Boise, Idaho USA

September 2010

For regulatory topics only:
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European Contact: Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard GmbH, Department HQ-
TRE / Standards Europe, Herrenberger Strasse 140, D-71034, Böblingen (FAX:
+49-7031-14-3143) www.hp.com/go/certificates

USA Contact: Product Regulations Manager, Hewlett-Packard Company, PO Box 15, Mail Stop 160, Boise, Idaho
83707-0015 (Phone: 208-396-6000)
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Declaration of conformity (wireless models)
Declaration of Conformity

according to ISO/IEC 17050-1 and EN 17050-1

Manufacturer's Name: Hewlett-Packard Company DoC#: BOISB-1001.01-rel.1.0

Manufacturer's Address: 11311 Chinden Boulevard

Boise, Idaho 83714-1021, USA

declares, that the product

Product Name: HP LaserJet Professional CP1025nw

Regulatory Model Number2) BOISB-1001-01

SDGOB – 0892 – (Radio Module)

Product Options: ALL

Print Cartridges: CE310A, CE311A, CE312A, CE313A

conforms to the following Product Specifications:

SAFETY: IEC 60950-1:2005 / EN60950-1: 2006

IEC 60825-1:2006 / EN 60825-1:2007 Class 1 Laser/LED Product)

IEC 62311:2007 / EN 62311:2008

GB4943-2001

EMC: CISPR22:2005 +A1 / EN55022:2006 +A1 - Class B1)

EN 61000-3-2:2006

EN 61000-3-3:1995 +A1 +A2

EN 55024:1998 +A1 +A2

FCC Title 47 CFR, Part 15 Class B1) / ICES-003, Issue 4

GB9254-2008, GB17625.1-2003

Radio5) EN 301 489-1:V1.8.1 / EN 301 489-17:V1.3.2

EN 300 328: V1.7.1

FCC Title 47 CFR, Part 15 Subpart C (Section 15.247) / IC: RSS-210

ENERGY USE: Regulation (EC) No. 1275/2008

Supplementary Information:

The product herewith complies with the requirements of the R&TTE Directive 1999/5/EC Annex IV, EMC Directive 2004/108/EC and the

Low Voltage Directive 2006/95/EC, the EuP Directive 2005/32/EC and carries the CE-Marking  accordingly.
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This Device complies with Part 15 of the FCC Rules. Operation is subject to the following two Conditions: (1) this device may not cause
harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired
operation.

1. The product was tested in a typical configuration with Hewlett-Packard Personal Computer Systems.

2. For regulatory purposes, this product is assigned a Regulatory model number. This number should not be confused with the product
name or the product number(s).

3. This product uses a radio module device which Regulatory Model number is SDGOB-0892 as needed to meet technical regulatory
requirements for the countries/regions this product will be sold.

Boise, Idaho USA

September 2010

For regulatory topics only:

European Contact: Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard GmbH, Department HQ-
TRE / Standards Europe, Herrenberger Strasse 140, D-71034, Böblingen (FAX:
+49-7031-14-3143) www.hp.com/go/certificates

USA Contact: Product Regulations Manager, Hewlett-Packard Company, PO Box 15, Mail Stop 160, Boise, Idaho
83707-0015 (Phone: 208-396-6000)
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Safety statements

Laser safety

The Center for Devices and Radiological Health (CDRH) of the U.S. Food and Drug Administration
has implemented regulations for laser products manufactured since August 1, 1976. Compliance is
mandatory for products marketed in the United States. The device is certified as a “Class 1” laser
product under the U.S. Department of Health and Human Services (DHHS) Radiation Performance
Standard according to the Radiation Control for Health and Safety Act of 1968. Since radiation
emitted inside the device is completely confined within protective housings and external covers, the
laser beam cannot escape during any phase of normal user operation.

WARNING! Using controls, making adjustments, or performing procedures other than those
specified in this user guide may result in exposure to hazardous radiation.

Canadian DOC regulations

Complies with Canadian EMC Class B requirements.

« Conforme à la classe B des normes canadiennes de compatibilité électromagnétiques. « CEM ». »

VCCI statement (Japan)

Power cord instructions

Make sure your power source is adequate for the product voltage rating. The voltage rating is on the
product label. The product uses either 110-127 Vac or 220-240 Vac and 50/60 Hz.

Connect the power cord between the product and a grounded AC outlet.

CAUTION: To prevent damage to the product, use only the power cord that is provided with the
product.

Power cord statement (Japan)

EMC statement (Korea)
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Laser statement for Finland

Luokan 1 laserlaite

Klass 1 Laser Apparat

HP LaserJet Professional CP1025, CP1025nw, laserkirjoitin on käyttäjän kannalta turvallinen luokan
1 laserlaite. Normaalissa käytössä kirjoittimen suojakotelointi estää lasersäteen pääsyn laitteen
ulkopuolelle. Laitteen turvallisuusluokka on määritetty standardin EN 60825-1 (2007) mukaisesti.

VAROITUS !

Laitteen käyttäminen muulla kuin käyttöohjeessa mainitulla tavalla saattaa altistaa käyttäjän
turvallisuusluokan 1 ylittävälle näkymättömälle lasersäteilylle.

VARNING !

Om apparaten används på annat sätt än i bruksanvisning specificerats, kan användaren utsättas för
osynlig laserstrålning, som överskrider gränsen för laserklass 1.

HUOLTO

HP LaserJet Professional CP1025, CP1025nw - kirjoittimen sisällä ei ole käyttäjän huollettavissa
olevia kohteita. Laitteen saa avata ja huoltaa ainoastaan sen huoltamiseen koulutettu henkilö.
Tällaiseksi huoltotoimenpiteeksi ei katsota väriainekasetin vaihtamista, paperiradan puhdistusta tai
muita käyttäjän käsikirjassa lueteltuja, käyttäjän tehtäväksi tarkoitettuja ylläpitotoimia, jotka voidaan
suorittaa ilman erikoistyökaluja.

VARO !

Mikäli kirjoittimen suojakotelo avataan, olet alttiina näkymättömällelasersäteilylle laitteen ollessa
toiminnassa. Älä katso säteeseen.

VARNING !

Om laserprinterns skyddshölje öppnas då apparaten är i funktion, utsättas användaren för osynlig
laserstrålning. Betrakta ej strålen.

Tiedot laitteessa käytettävän laserdiodin säteilyominaisuuksista: Aallonpituus 775-795 nm Teho 5 m
W Luokan 3B laser.

GS statement (Germany)

Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz
vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt
nicht im unmittelbaren Gesichtsfeld platziert werden.
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Substances Table (China)

Restriction on Hazardous Substances statement (Turkey)

Türkiye Cumhuriyeti: EEE Yönetmeliğine Uygundur
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Additional statements for wireless products

FCC compliance statement—United States

Exposure to radio frequency radiation

CAUTION: The radiated output power of this device is far below the FCC radio frequency exposure
limits. Nevertheless, the device shall be used in such a manner that the potential for human contact
during normal operation is minimized.

In order to avoid the possibility of exceeding the FCC radio frequency exposure limits, human
proximity to the antenna shall not be less than 20 cm ( (8 in)) during normal operation.

This device complies with Part 15 of FCC Rules. Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including
interference that may cause undesired operation of the device.

CAUTION: Based on Section 15.21 of the FCC rules, changes of modifications to the operation of
this product without the express approval by Hewlett-Packard Company may invalidate its authorized
use.

Australia statement

This device incorporates a radio-transmitting (wireless) device. For protection against radio
transmission exposure, it is recommended that this device be operated no less than 20 cm from the
head, neck, or body.

Brazil ANATEL statement

Este equipamento opera em caráter secundário, isto é, não tem direito à proteção contra
interferência prejudicial, mesmo de estações do mesmo tipo, e não pode causar interferência a
sistemas operando em caráter primário.

Canadian statements

For Indoor Use. This digital apparatus does not exceed the Class B limits for radio noise emissions
from digital apparatus as set out in the radio interference regulations of the Canadian Department of
Communications. The internal wireless radio complies with RSS 210 of Industry Canada.

Pour l´usage d´intérieur. Le présent appareil numérique n´émet pas de bruits radioélectriques
dépassant les limites applicables aux appareils numériques de Classe B prescribes dans le
règlement sur le brouillage radioélectrique édicté par le Ministère des Communications du Canada.
Le composant RF interne est conforme à la norme CNR-210 d´Industrie Canada.

European Union regulatory notice

The telecommunications functionality of this product may be used in the following EU and EFTA
countries/regions:

Austria, Belgium, Bulgaria, Cyprus, Czech Republic, Denmark, Estonia, Finland, France, Germany,
Greece, Hungary, Iceland, Ireland, Italy, Latvia, Liechtenstein, Lithuania, Luxembourg, Malta,
Netherlands, Norway, Poland, Portugal, Romania, Slovak Republic, Slovenia, Spain, Sweden,
Switzerland, and United Kingdom.
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Notice for use in France

For 2.4 GHz Wireless LAN operation of this product certain restrictions apply: This equipment may be
used indoor for the entire 2400-2483.5 MHz frequency band (channels 1-13). For outdoor use, only
2400-2454 MHz frequency band (channels 1-9) may be used. For the latest requirements, see
www.arcep.fr.

L'utilisation de cet equipement (2.4 GHz Wireless LAN) est soumise à certaines restrictions : Cet
équipement peut être utilisé à l'intérieur d'un bâtiment en utilisant toutes les fréquences de
2400-2483.5 MHz (Chaine 1-13). Pour une utilisation en environnement extérieur, vous devez utiliser
les fréquences comprises entre 2400-2454 MHz (Chaine 1-9). Pour les dernières restrictions, voir,
www.arcep.fr.

Notice for use in Russia

Существуют определенные ограничения по использованию беспроводных сетей (стандарта
802.11 b/g) с рабочей частотой 2,4 ГГц: Данное оборудование может использоваться внутри
помещений с использованием диапазона частот 2400-2483,5 МГц (каналы 1-13). При
использовании внутри помещений максимальная эффективная изотропно–излучаемая
мощность (ЭИИМ) должна составлять не более 100мВт.

Korean statement

Taiwan statement
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paper
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settings 19
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paper, covers
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printing (Windows) 58
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recycling 80, 145
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warranty 134

print job
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printing 117
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printer driver
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